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Nuxeo DM 5.3.2 User Guide

About Nuxeo DM

Nuxeo DM is Nuxeo's collaborative document
management application, based on our open source ECM
platform Nuxeo EP. Nuxeo DM provides organizations with
the application they need to enable their teams to work
more efficiently either on a project-basis or on longer term
business processes.

Collaborative work takes place in workspaces, where you
can create documents, share and edit them. When
documents are ready for distribution, you can publish them
in sections, which are the spaces devoted to content
distribution.

You can come and discuss Nuxeo DM with other users on
our discussion forum.

Nuxeo DM User Guide

Nuxeo DM's concepts
Browsing content in Nuxeo DM
Working in workspaces
Managing Nuxeo DM

Working in sections
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Nuxeo DM is Nuxeo's collaborative document management application. It distinguishes collaborative work and content distribution.

The general concept is here : documents are created, edited, possibly approved in workspaces. When finished, they are published in sections.
When obsolete, they're unpublished from sections. Actions users can perform on documents are determined by access rights given by spaces
managers. To encourage collaborative work and information sharing, Nuxeo DM proposes several collaborative services, such as forums, blogs
and websites.

Available spaces

Collaborative work takes place in workspaces, where users can create and edit documents. Workspaces are designed to make capture, sharing
and editing of documents easier using desktop integration features, comments, annotations. In the mean time, documents history and versioning,
relations, workflows and alerts enable you to build a coherent and controlled documents structure.

To help users create the workspaces in which they work, you can create workspaces templates and prepare the structure that will be applied to
workspaces used in template-based workspaces.

When documents are finished and ready, they are published in sections. Traditionally opened to a wider audience than workspaces, sections are
dedicated to content distribution and communication and are designed for content consultation. That is why you won't be able to change
documents (edit or move them) in sections : documents published in sections are frozen versions of workspace documents. Sections are . Publish

ing is controlled using a workflow, that requires publishing requests to be approved so documents can be seen in sections.

Sections, workspaces and templates are grouped in domains. A domain can be considered as a mini-application in Nuxeo or a root in the
application. Typically you can use domains to open the application to 2 or more very different populations of users. For instance, you can have an
"intranet" domain and an "extranet" domain. Domains are can be totally independent or not, depending on the access right you set on each

domain.

Access rights

Access to documents and the actions allowed are determined by access rights. Some users will then be allowed to only read documents, when
others will be able to edit documents or to manage spaces and documents.

The available access rights are:

Right

Read

Write

Manage

Remove
Can ask for publishing
Comment

Moderate

Actions in workspaces

Consult content
Comment documents
Annotate documents
Tag documents

Create documents
Edit documents

Add / remove relations
Start a workflow

+ read actions

Manage access rights

Set alerts to other users

Apply a preset look on documents
Manage deleted documents

+ write and read actions

Delete documents

Add comments on websites

Moderate comments on websites and blogs if

moderation is set to "Beforehand"

Actions in sections

Consult content
Comment documents
Annotate documents
Tag documents

Create sections
+ read actions

Manage access rights

Set alerts to other users

Apply a preset look on documents
Manage deleted documents

+ write and read actions

Submit documents for publishing

Access rights are given on folderish spaces (workspaces, sections, templates, domains, but also folders, blogs, websites etc) and are inherited in

the sub-spaces.

@ On a standard Nuxeo DM application, members are all granted ‘read' right at the application's root by default.

Groups of users
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To make access rights management easier, you can create groups of users. Instead of giving (or denying) access rights to single users and
repeat the same operations several times, you can give several users the same right in one single manipulation by using a group.

Default groups are:

® administrators: users in this group are the administrators of the application. They are in charge of managing the application and can edit
the vocabularies, manage users and groups, and manage the themes applied in the application.
®* members: users in this group are the non-administrator users of the application.

(D Users must be in one of these 2 default groups to be able to access content.

You can create as many groups as needed.

Browsing content in Nuxeo DM

To help you find accurate documents, Nuxeo DM features several different ways to access documents:

® The different navigation trees, the tag cloud, or the dashboard enable you to browse content according to different axis.
® You can also use the simple or advanced search.

For each of the available means to access documents, you can customize the informations displayed.

Access content

There are different ways to access content in Nuxeo DM. You can either use one of the navigation trees available, the tag cloud or your
dashboard.

Navigation trees

Several navigation trees are available so that you can access your documents either by going through folders (physical navigation) or using virtual
navigation.

Navigation through folders

The default navigation tree displayed on the left hand side of the pages is the folders navigation tree. It displays all the domain structure from the
root. It enables you to easily access any space in the application structure.

= [_.J Clobal Document Repository
= Publishing sections
5 | IT publishing sections

Quality / Procedure
sections

= [(£2 Workspace Templates
;3 56 Governmental project
;3 (58 IT project
= £ Workspaces
3 [E8 Cross-functional Projects
o3 & 1T project
3 |3 Organizational structure

Virtual navigation

Another way to access documents is using virtual navigation. Virtual navigation consists in using a navigation tree based on metadata to access
documents. Metadata are informations about the documents, like the document's theme for instance, or its last modification date.

By default, two virtual navigation trees are available in Nuxeo DM: geographical cover navigation tree and subject navigation tree. You can use
them for instance to access all the documents about the IT subject.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 5
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=2 ¢ @ Ii

Browsing by subjects
Art
Human science

= ¢

Society
Daily life

O E B e el
I

| Technology

=| Astronautic
Electronic
Energy
Industry
IT
Robotic

() [ [ i) [ [ (i

Transport

You can replace or edit existing virtual navigation trees with you organzation's own vocabularies. Thus, you'll be able to adapt Nuxeo DM to your
organization's structure and way of working.

See also pages Editing the document's content and metadata and managing vocabularies.

Tag Cloud

Nuxeo DM includes tagging of documents, which enables you to apply your own labels on documents. The tag cloud lists all tags on documents,
with their size growing as the tag is applied on several documents.

= @ |G

5.3 studio planning ep dam
documentation screencast
screenshots ecm architecture

dm 5.2 website user guide
marketing

To see all documents tagged with the same label, click on the tag in the tag cloud.

Dashboard

You can also access documents using your dashboard.
Every user has a dashboard that he can customize. The purpose of the dashboad is that the user can have a summary of the application's activity
on one page.

nuxeo:DM o

Defaultdomain % Change  Back to docurnent base
' Change Layout
P Add A Widget
RER HFEE
ORORAOR0 CRCRAIONC
Task Name Due date Directive Title Last modified at Author
S| Huxeo DM Instsll Guide Tuesday, May 25, 2010 11:11 jdoe
Nuxeo 5.2 User Guide Friday, May 21, 2010 4:41: jdoe
eex @
TRORLIORC B Muxeo 5.3 User Guide Friday, May 21, 2010 11:54 jdoe
Title Last modified at Author
[E  Functional documentation Monday, May 17, 2010 6:04: Administrator
[ Marketing Tuesday, May 25, 2010 11:11 jdoe
[E  Technicsl documentation Monday, May 17, 2010 6:04: jdoe
B idoe Tuesday, May 25, 2010 12:42 system
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To access your dashboard, click on the Dashboard link in the page header.

You are logged as jdoe | Dashboard | Personal Workspace | Users & groups | Log out

Change content presentation

You can change the way content is presented:

® in the folderish repositories (workspaces, folders, sections)
® in your dashboard

Presentation options in folders

Different views of the content lists are available in workspaces, folders and sections:

® Jist view (default view):
Functional documentation =

‘Content Edit Alerts History Manage

New | Import a file

(=] Title & Modified Author Version State
O ] NuxeoDAM 1.1 User Guide o7 & 10/1/10 11:13 AM John Doe 10 Project
O ] NuxeoDM 5.3.2 User Guide o & 10/1/10 11:13 AM John Doe 1.0 Project
Paste Add to worklist Copy Delete

® icons view:
Functional documentation =

Content Edit Alerts History Manage

New | Importafile
=] Nuxeo DAM 1.1 User Guide 7 & =] Nuxeo DM 5.3.2 User Guide o7 &
Paste Klist Copy Delet

® compact view:
Functional documentation =

Content Edit Alerts History Manage

New | Import a file
=] @ Nuxeo DAM 1.1 User Guide &7 (=] @ Nuxeo DM 5.3.2 User Guide 7 &
10/1/10 11:13 AM 10/1/10 11:13 AM
John Doe John Doe
Project Project
L0 Lo
Paste Add to worklist Copy Delete

To change presentation, click on one of the icons displayed on the top right corner of Content tab:

® |[ist view icon:
® jcon view icon:

® compact view icon:

Customize your dashboard

When you customize your dashboard, you can change the layout of the page, but you can also edit the widgets displayed.

Change dashboard layout

Copyright © 2010-2016 Nuxeo.
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To change your dashboard's layout:

1. Click on Change layout.
The layout panel unfolds.

nuxeo - DM ‘“You are logged as jdoe | Dashboard | Personal Workspace | Users & groups | Log out Advanced search

2. Click on the layout you want to apply for your dashbord.
3. Click on Close.
The chosen layout is immediately applied.

]

\
1 \
i |
1 \
i |
1 \
i |
1 \
i | Default Domain 4| Change Back to document base 1
i |
1 \
| Close H
1 \
1 \
i 1 |
1 \
1 2 |
1 \
i 3 |
1 \
i 5 |
1 \
i |
1 . \
1 Add A Widget 1
i |
1 \
i |
' vl (X 3] (X '
H COBNCVRE 14 RO i
H ) (&) : - S 1
| Titre Derniére modification Auteur H
1 \
H EIX @ Nuxeo DM 5.3.2 User Guide 10/01/2010 11:24 jdoe H
1 i
i wom pe | Nuxeo DAM 1.1 User Guide 10/01/2010 11:24 jdoe E
1 N ,_ I i
' Titre Derniére modification Auteur | Brochure 10/01/2010 11:23 jdoe H
| [E  Cross-functional Projects 10/01/2010 11:14 Administrator ]  Meradata mapping 10/01/2010 1122 Jdoe H
1 \
1 [Ed  Functional documentation 10/01/2010 11:12 Administrator H
1 \
1 \
! [E Technical documentation 10/01/2010 11:14 Administrator '
1 \
H E  idoe 10/01/2010 11:20 system i
i |
1 \
i |
1 \
i |
1 \
i |
1 \
i |
1 \
1 i

Organize your widgets

You can organize widgets the way you want in the applied layout. You can thus move widgets from a place to another (in another column, at the
bottom or the top of the page, etc).
To move widgets, drag and drop them from a place to another.

nuxeo - DM o ashboard | Personal Workspace | Users & groups | Log out
| Default Domain ‘4| Change Back to document base
Change Layout
Add A Widget
R =3B )13 [
ORORIINONC
=@ " o
Titre Derniére modification Auteur

_________________________________________________ |
! 1 @] Nuxeo DM 5.3.2 User Guide 10/01/2010 11:24 jdoe

'
: 1 @ Nuxeo DAM 1.1 User Guide 10/01/2010 11:24 Jdoe

1
'
[ : <] Brochure 10/01/2010 11:23 Jdoe
1
1 ' Metadata mapping 10/01/2010 11:22 jdoe
1

1
'

1
1

'
1

'
1

1
'

1
'

1
: '

@ You don't need to install Nuxeo's Drag and Drop extension to move widgets.

Add and remove widgets

You can choose the widgets that are displayed on your dashboard.

Add widgets

Copyright © 2010-2016 Nuxeo.
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1. Click on Add a widget.
2. Click on the Add button of the widget you want to display on your dashboard.
3. In the window that is displayed, change the widget's title and colors (optional) and click on Save button.

H
1

1

1

1

i |
1 \
i |
1 \
i |
1 \
i nuxeo - DM You are logged as jdoe | Dashboard | Personal Workspace | Users & groups | Log out _ Advanced search i
i |
| Default Domain %] Change Back to document base H
i |
1 \
! Change Layout '
H 1
| Close H
1 \
1 \
! News Todo list Note i
1 \
H Nuxea ol ¥ H
H d notes Preferences for gadget 'my todo list' H
1 Utilities \ 1
1 i
H Media — H
| Collaborative services Add Add Titre: my todo list H
1 \
i Encadre : EEN | [ E
i Police : N | X H
1 i
' Bordure : EEN [ | ] i
: " :
1 \
1 \
H Derniére modification Auteur |
: o :
1 10/01/2010 11:24 jdoe H
1 i
1 \
! 10/01/2010 11:24 jdoe !
1 i
H Titre Derniére modification Auteur [£2] Brochure 10/01/2010 11:23 jdoe H
1 Cross-functional Projects 10/01/2010 11:14 (bt e 1040172010 11:22 jdoe H
1 \
! Eunctional documentation 10/01/2010 11:12 Administrator !
1 \
i Technical documentation 10/01/2010 11:14 Administrator |
1 \
1 \
! doe 10/01/2010 11:20 system !
1 \
1 \
i |
1 \
i V

4. Move the widget in the dashboard at the place you want it to be displayed.

1. Click on the icon of the widget you want to delete from your dashboard.
2. On the window that pops up, click OK to delete the widget.
The widget is removed from your dashboard.

Edit widgets

At any time, you can edit widgets and change their title or colors to change the look of your dashboard.

1. Click on the icon .

2. In the modal window displayed, change the widget's parameters.
3. Click on Save.

Search Nuxeo DM

Nuxeo DM integrates a full text query engine, designed to recognize all the specific parameters the application provides.

e

Documents are indexed using their title, description, content (note field, attached files), and metadata.

Simple search

Simple search can be accessed from any site page. At any time, you can search a document by typing keywords in the search box located at the
upper right corner of the page and clicking the Search button.

Search results are displayed in a table. Click on the document's name to open it.

Copyright © 2010-2016 Nuxeo.
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Search results :
Export to Excel (CSV)
(] Title Creation date Modification date Description Contributors
a [E§  Functional documentation 10/1/10 10/1/10 Administrator
=] [E  Technical documentation 10/1/10 10/1/10 Administrator
O = Cross-functional Projects 10/1/10 10/1/10 Administrator
8 @J Metadata mapping 10/1/10 10/1/10 jdoe
O H]| srochure 10/1/10 10/1/10 jdoe
(] @ Nuxeo DAM 1.1 User Guide 10/1/10 10/1/10 Nuxeo Digital Asset Management (1.1} user guide Jdoe
=] @ MNuxeo DM 5.3.2 User Cuide 10/1/10 10/1/10 User guide of version 5.3.2 of Nuxeo Decument Management jdoe

Nuxeo DM search engine uses boolean operators, to enable you to associate keywords. The Boolean operators used by Nuxeo DM search
engine are:

® +:the word after the + symbol must be in the found documents.

Example: you are looking for documents that must contain "Nuxeo" and may contain "release". Type release +Nuxeo.
® -: The keyword after this symbol must not be in the found documents.

Example: you are looking all the documents referring to the Nuxeo but not about meetings. Type Nuxeo -meeting.

Advanced search

Advanced search enables you to search a document using more precise parameters. You can for instance select metadata of the searched
document or the date of specific events such as publication, creation.

Click on the Advanced search link, located next to the search box.

—

2. Type your criteria in the Search criteria form.
3. Possibly, choose your sorting criteria.

4. Click on the Search button.

Search results are displayed in a table. Click on the document's name to open it.

Search results export

You can export the results of your search as a MS Excel document. This enables you to save the search results to consult them later.

When you export search results as an Excel document, the exported document contains the same informations as the search results table. The
default informations are the document's title, and its creation and modification dates.

To export search results, click on the Export Excel link, located above the search result table.

Search results customization

You can choose which informations are displayed on the results page. The default informations are the document's title, its creation date and its
modification date. You can add or remove fields from search results display.

All users can customize search results columns.

Adding new search results columns

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 10


http://doc.nuxeo.com/x/GATF

NU32Ze O Nuxeo Document Management 5.3 Documentation Center

1. Click on the Advanced search link in the top rights corner of the page.
The Search results columns form is displayed below the Search criteria form.

Schema Selectavalue | Field Select a value
uid
Dublincore Add field

Title® Creation date® Modification date @ Description ™
Order By Selectavalue ||

Order Direction
O Ascending @ Descending

2. Select a schema.
® The Uid schema includes versioning informations.
® The Dublincore schema includes metadata informations.
The fields corresponding to the selected schema are displayed in the Field selection list.
3. Select the field to add and click on the Add field button.
The new field is added at the end of the result columns.

Schema Selectavalue | | Field Modification date *
Uid Issue date . .
Dublincore Vvalidation date Add field]

Expiration date m

Contributors. .

Title® Creation date® Modification date © Description® Contributors®

Order By Selectavalue  v|

Order Direction
(O Ascending @ Descending

Removing search result columns

To remove a column, click on the icon @ after the column name.

Moving search result columns

You can move the search results columns to modify their order. To move a column, drag it and drop it on the column at the place of which you
want it to be. For instance, from the screenshot above, if you want the Description column to be the second one in the table, drag it and drop it on
the Creation date column. The Description column replaces the Creation date column, and the Creation date column takes the place of the
Description one.

Changing search result sorting

You can sort the results on any of the search results column. You can also change the order direction.

Working in workspaces

Workspaces are spaces dedicated to collaborative work. It is the place where you will be able to create, share and edit documents.

You can also use collaborative services like forums, websites or blogs to communicate ans share information with the other users.

Working with workspaces

There are two types of workspaces:

® collaborative workspaces are are workspaces meant for collaborative work, that is to say that the workspace's content is meant to be
shared and modified by several users. Collaborative workspaces are workspaces created in the root space called Workspaces and
shared between users. Once documents are ready for distribution, they must be published in a section.

® personal workspaces can only be accessed by their owner, by default. You can of course share the access to your personal workspace
with other users. Personal workspaces are accessible in the header of the application.

Copyright © 2010-2016 Nuxeo.
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@ Content creation and edition, as well as management, works the same way in personal workspaces as in collaborative workspaces.

By default, no workspace is available at workspaces root. Thus, you can create the structure you need for your project, edit it if needed. You can
also set the appropriate access right for users to be able to collaborate in the workspaces.

Workspaces management also includes setting alerts for users to be informed when content is created or edited in workspaces and handling
content deletion.

Creating a workspace

Workspaces are created in the Workspaces rootspace, either at the root of Workspaces or in subworkspaces. By default, no workspace is
available in Nuxeo DM so that you can create the structure needed for your project. You can create as many workspaces and subworkspaces as
you need.

Workspaces can be created from scratch or from a template.

Create a workspace from scratch

To create a new workspace, you need to have at least 'Write' rights in the parent folder.

1. Click on the New Document button (New Workspace if you are the root of workspaces).
2. On the Available document types window, click on Workspace.
3. Give the workspace a title and possibly a description.
4. Click on Create button.
The workspace's Content tab is displayed.

Documentation

]
\
\
i
\
\
i
\
\
i
\
\
i
\
\
i
i

All the documentation about Nuxeo DM H
\
i
\
\
i
\
\
i
\
\
i
\
\
i
\
\
i
\
\

Edit My subscriptions History Manage
@ Workspace saved

New decument Import a file

This folder contains no document.

Create a workspace from a template

Templates are predefined workspaces that you can use to make building your workspace structure easier.

When you create a workspace from a template, the newly created workspace automatically have the same content and description as its
template. Access rights however are not inherited from the template but from the parent workspace.

1. Click on the New Document button (New Workspace if you are the root of workspaces).

. Give the workspace a title, possibly a description and select the template to create the workspace from in the drop down
list.
4. Click on Create button.

2. On the Available document types window, click on Workspace.
; 3 :
: The workspace's Content tab is displayed. :

Editing a workspace

To edit a workspace, you need to have Manage right on the workspace.

When you edit a workspace, you can edit its properties (title and description) and its metadata.

1. Click on the Edit tab of the workspace. i
2. Edit the edition form's fields.
3. Optionally type a comment to keep track of why you edited the workspace. :
4. Click on the Save button.

Modifications are saved and the fact that you edited the workspace is tracked in History tab. :

Deleting a workspace
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Only users with writing or management rights in the parent workspace can delete a workspace.

When you delete a workspace, you also delete its content. This action moves the workspace into the parent's trash, from which users with
management rights can revert deletion or delete it permanently.

1. In the Content tab of the parent workspace, check the box corresponding to the workspace to delete.
2. Click on the Delete button. :
3. In the window that pops up, click on the OK button.

The parent workspace's Content tab is displayed: the deleted workspace is not displayed anymore. :

Sy b iy sy, gyttt g ettt i fop i hoysefhvauu pyy? Sy iutpser oo S

Manage a workspace

Users with management rights can parameter the workspace.

All management actions are available in the Management tab of the workspace.
This is the place where you can:

set access rights on the workspace to define who can read the content, edit it or delegate management of the workspace
set alerts for other users so they get automatically informed of the content evolution

manage deleted documents in the workspace Trash,

change the look of the workspace by choosing a preset theme

define the sections in which users will be able to publish from the document (called publication targets)

Manage deleted documents

When they are deleted by users with writing rights, documents are moved into the Trash tab of the parent folder (domain, workspace, folder, etc).
They are not erased from the application. Users with management rights can still restore them or delete them permanently.

Restore documents

Only users with management rights can restore documents.

When they are deleted by users with writing rights, documents are moved into the Trash tab of workspaces or folders. They are not erased from
the application and can still be restored, i.e. moved back into the Content tab of the workspace.

1. Go on the Trash tab of the workspace.

Content Edit My subscriptions History Manage

Access rights Theme Subscriptions Publication targets Trash

(0 | MNuxeo 5.1 User Guide ' & 4/23/10 4:26 PM
Permanent delete Restore

2. Check the box in front of the document's name.
3. Click on the Restore button.
4. On the window that pops up, click on the OK button.
The document is moved back into the Content tab of the workspace.
It takes the 'project' life cycle state, even if its life cycle state before deletion was 'approved' or ‘obsolete’.

O Title & Modified

Permanently delete documents

Only users with management rights can manage the trash of a space and delete documents permanently.
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1. In the Trash tab of the workspace, check the box in front of the document's name.

Content Edit My subscriptions History Manage

Access rights Theme Subscriptions Publication targets Trash

O @ Nuxeo 5.1 User Guide 7 § 4/23/10 4:26 PM
Permanent delete Restore

2. Click on the Permanent delete button.

3. On the window that pops up, click on the OK button.
The document is permanently erased from the application. It cannot be restored.
The relations from and to the deleted document are updated and are displayed as a URI relation: the deleted document is
displayed as an external document, identified by its reference (URI).

O Title & Modified

Set publication targets

In order to guide users when they publish documents and make sure documents are published in the correct sections, you can define publication
targets for the workspace's documents. Publishing targets are sections in which the documents from the workspace will be publishable. Users will
then be able to publish documents only in the sections you have defined.

By default, workspaces don't have any targets defined.
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1. Click on the Manage tab of the workspace.
The Access Rights tab is displayed by default.
2. Click on the Publication targets tab.
If no section has been defined yet, users can submit documents to publishing in any section (providing they have the rights
to publish).
3. Unfold the sections tree and click on the Add link of the sections to which you want to restrict publishing from this
workspace.
The selected sections are displayed in a table below the tree. No Add link is available anymore for these sections.

Cross-functional Projects =

Content Edit Alerts History

Access rights Theme Alerts Publication targets Trash

Sections | Sections j |

o L Sections

o DT publishing sections 4 add
g | Products documentation

= == Quality / Procedure sections  Add

i3 [ Release procedures

Selected sections
Title

@ Default domainzSections>Products documentatien

@ Default domain=>Sections>Quality / Procedure sections>Release procedures

When they click on the Publish tab of documents to publish a document, users are still displayed all the sections they have
"Read" right on, but the Publish here link is now available for the selected sections only.
4. Click on the icon to remove a section from the workspace's targets.

Brochure =

Summary Edit Files m Relations Workflow Alerts Comments History Preview Manage

Sections | Local Sections (Default domain) j|

= |} Sections
2 ] Products documentation @ Publish here

4 [ Quality guidelines ¢ add
ol 2 Release procedures ©publish here ;

Apply preset look to a space

Administrators can easily apply a preset theme to a workspace, template or section. You can apply a theme to spaces only. For instance, you can
change the theme of sections, so that they look different from workspaces, but you cannot change the look of a document.

{:D The new space's theme is not applied to the sub-spaces, but it is applied to the documents it contains.

When you choose to apply a theme to a workspace, for instance, you can refine what is displayed on the page by applying a perspective on the
theme. A perspective is a fragment visualisation mask that determines that some parts of the page, like the clipboard and worklist, are not
displayed to the user if specified conditions are met. The default application has only one perspective.
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1. Click on Manage tab of the space.
2. Click on the Theme sub-tab.

Content Edit My subscriptions History Manage

Local theme configuration

Access rights Theme Subscriptions Publication targets

Theme | galaxy ﬂ|

Page | default ﬂl

Perspective | {Not specified) ﬂ|
Save

Trash

3. Select the theme, page and perspective you want to apply.
4. Click on the Save button.

Working with documents

Nuxeo DM is a collaborative document management application. That is to say that you can create, edit and share documents within the

application.
Documents are sorted in two categories:

® collaborative services
® documents

Collaborative services are folderish documents that enable users to share information:

Workspaces
Folders

Picture book

Mail folder

Forum

Websites and blogs

Documents available in Nuxeo DM are:

® the note: a text typed in a rich editor integrated to Nuxeo DM;
® the file: an attached file;
® the picture: a picture file with specific features available;

The evolution of a document, each time contributors edit it, constitutes its life cycle. This life cycle is composed of the following states:

® project: the document has been created and it can be modified;

°

°

® deleted: the document is moved into the workspace's or folder's trash.
To change the life cycle state of a document, you need to submit it to a workflow.

Create content

You need to have writing or management rights to create documents.

Documents can be created in workspaces, templates and folders only. There are several ways to create documents in Nuxeo DM. You can:

® create all content types from the “Content” tab of the workspace and filing the appropriate form (see below),

® use drag and drop from your desktop, to import one or several documents,
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® create documents directly from MS Office or OpenOffice, using Nuxeo LiveEdit extensions.

Create a document using New document button

Creating a document using the New document button enables you to select the type of document you want to create among all Nuxeo DM's
document types.

To create a document using New document button:

1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

Available document types @

Select the type of your new document in the list below.

Document Collaborative Services
(] Picture Folder Forum
File . Blog Site Email folder
_ﬁ Note . Workspace m PictureBook
WebSite b

3. Fill in the document's creation form.
4. Click on the Create button.

The Summary tab of the document is displayed.

Create a document using Import a file button

You can use the Import a file button to create a document in a faster way. Using this button, you won't need to fill the creation form.
Depending on the uploaded file type, the system will create a note, a file or a picture.

1. In the Content tab of the workspace, click on the Import a file button.
2. On the Create a new file window, click on the Add button to select the file to be uploaded.

Create a new file (]

Select the file to import

o Add..

Upload Cancel

3. Click on the Upload button.
The Summary tab of the document is displayed. The document automatically takes the name of the uploaded file as its
titte. The document has no description. You need to modify the document to fill in this field.

Edit content

Documents can be edited by users with writing rights in a folder.

Documents can be edited in workspaces only. If you want to modify a published document, you need to edit it in the workspace and republish it.
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Document modification means:

® editing or changing the attached file of a file document,
® editing the text of a note,
® or simply editing the title, description or any metadata of the document.

Versioning overview

Nuxeo Document Management 5.3 Documentation Center

Every time you modify a document, you have to define how the version number is updated.

Update versions

f®) Skip version increment
" Increment minor version

': Increment major version

Every document holds a version number, which is a piece of information about the evolution of the document. A version number (V.v) is
composed of a major version number (V) and a minor version humber (v). When a document is created, its version number is 1.0. Major version
increment is reserved to significant modifications. Minor version increment is used for secondary changes.

Metadata overview

Metadata are information describing some properties of the workspace, so that they are more accurately referenced. Some metadata are
automatically filled in by the system, but most of them need to be filled in by users. When you create a document (file, note, workspace, section,
or any other document type), its metadata are empty.

Nuxeo DM uses Dublin Core metadata by default. They are listed below:

Field

Subjects

Rights

Source

Coverage

Created at

Last modified at

Format
Language

Expire on

Author

Contributors

Description
Topic(s) of the document.

Information about the reproduction rights of the document. Rights
informations often encompass Intellectual Property Rights and
Copyright.

The references of the resource from which the document's content is
derived (totally or partially).

Information about the geographic reach of the document.

Date automatically filled in by the system when the document is
created.

Date automatically filled in by the system when the document is
modified.

Format of the document, if any is preferred.
Language used in the document.

Date on which the document stops being valid. Click on the calendar
icon to select a date.

This date is not indexed in the system. It is just in indication for users
but it is not processed by the application.

User who created the document. This field is automatically filled in by
the system.

Users who modified the document. This field is automatically filled in
by the system.

Although metadata are not mandatory, filling them in will make your documents easier to find using Nuxeo DM search engine or virtual navigation.

(D Coverage and subjects are used for virtual navigation.
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To fill in or change the metadata of the document, just edit the document.

Edit a document

1. Click on the Edit tab of the document.

on Edit.

@ You can also access the Edit tab directly from the folder's content using right click on the document and clicking

New document Impart a file

H Title &

= @ iMuxeo 5.1 User Guide ™ i

Faste Delete Copy

Rename

Delete

Download

Wiorkflow

y Lock

Preview

Email

Iiﬁl My subscriptions Histary

2. In the modification form displayed, type your modifications.
3. Indicate if you want to update the document's version.

Update versions ] o
f®) Skip version increment

") Increment minor version

" Increment major version

5. Click on the Save button.
The document's Summary tab is displayed.

e

@ MS Office and OpenOffice.org documents can be edited directly in their native application using Live Edit or WSS.

Deleting content

Only users with 'Write' or ‘'manage everything' rights can delete documents from a space.

Deleting a document occurs in two steps:

1. A user moves a document to trash.

4. Type a comment if you want to indicate why you modified the document.
This comment is logged in the document's history and helps other users know what has been changed on the document.
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2. The manager of the space deletes the document permanently.
(D The trash tab is displayed to users with management rights.

There are two ways to move a document into the Trash tab:

® Deleting it from the workspace content table,
® submitting the document to an workflow, with the destination lifecycle state 'deleted'.

If you are sure that the document is to be deleted, you can delete it from the workspace's content table. However, if you want the deletion to be
approved before, you need to submit it to a workflow and specify that the destination life cycle is 'deleted'. When the workflow is ended and the
deletion approved, the document is automatically moved into the Trash tab of the document.

1. In the Content tab of the workspace, check the box in front of the document's name.

2. Click on the Delete button.

3. On the window that pops up, click on the OK button.
The document is moved to the Trash tab of the workspace (available to users with management rights only) and does not
appear in the workspace's content list.

H
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1
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1
1
1
1
1
1
1
1
1
1
1
1
1
1
H New document Import a file
1
1
1
1
1
1
1
1
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1
1
1
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1
1
1
1
1
1
1

i

1

i

i

i

i

i

i

i

i

i

i

i

1

@ 1 Document(s) deleted | i

i

O Title & Modified Author State |
i

(=} |§|J AlIM Press List 2.17.09 " 4F 5/14/09 2:53 PM Alan Turing Project E
i

(=] = Analytics_www.nuxeo.com_200904_{GeoMapReport) . 5'{ 5/14/09 3:02 PM Alan Turing Project E
i

O & Architecturepr & 5/14/09 3:06 PM Bill Gates Project 1
i

= - !

B & sawement ol workpr ¥ 5/7/09 11:35 AM Administratar Project H
i

i

i

i

i

i

@ You can also delete documents using right click on document from the Content tab of the workspace.

Iial My subscriptions History

Mew document Import a file

O Title &

0 @ Nuxeos5.1 UserGuideir &

Paste Delete Copy

Delete

Download

Workflow

v Lock

Preview

Email

Note

The note is a document that consists in a text displayed in the Summary tab of the document. The note is usually created using the integrated
rich editor, displayed in the note creation form. This editor enables layout modifications on the text.
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Document creation &

All the procedures to create documents

Edit Files Publish Relations Workflow My subscriptions

Comments History Preview Manage

Description

All the procedures to create documents

How to create a note

1. Click on the New Document button.

2. On the Available document types window, click on Workspace.
3. Give the document a title and possibly a description.

4, Click on Create button.

The note's Summary tab is displayed.

Common metadata

Subjects
Rights
Source

Coverage

State Project Version 1.0

This document is unlocked | Lock

Content

Main File Document creation.html (366 B)

Associated tags

@Add tags

The default format of the note is HTML. The other formats available are .txt and .xml. Each format has an associate editor.

Summary Iiﬂ Files Fublish Relations Worldlow My subscriptions Comments History Preview Manage

S
Title | Muxeo DM Presentation

Description

Mote

environment, Nuxen DM

Muxeo DM is the ultimate ready to go collaborative docurmment managerment application
available on the market, Based on our popular open source ECM  platform Muxeo EP,
Muxeo DM benefits from its flexibility, feature scope, scalability and IS integration
capabilities. Muxeo DM provides organizations  with the application they need to
enable their teams to work moare  efficiently either on a project-basis ar on longer
term business processes, Muxep DM brings them the ability to create, share,
annotate, store and  retrieve any types of documents in their usual desktop

Format : Text +

A note is composed of the fields below:

Field

Title
Description
Content

Format

Description
Note's title
Text that explains what the note is about.

Text of the note created using a rich text editor.

Format of the automatically created file used to export notes from

Nuxeo DM.
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1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

3. Fill in the document's creation form.
4. Click on the Create button.

: Available document types @ :
E Select the type of your new document in the list below. :
Document Collaborative Services
i Picture Folder Forum
i File | . Blogsite Email folder H
: Note Workspace PictureBook :
| o WebSite n
i I i
: H

@ You can also create a note by importing a .txt, a .html or a .xml file using Import a file button or drag and drop.

When the note is created, users can enhance it by adding annotations , comments , attached files on it, or just editing it.

Files

A file document is composed of an attached file that you upload on the application.
@ You can upload files of any format.

A file is composed of:

® atitle (mandatory)
® adescription (optional)
® an attached file

Studio Overview - EN &

Publish Relations Workflow My subscriptions Comments History Preview

Content State Project Version 13

Main File & | Nuxeo Studio Feature Overview.odt (1 MB) [H This document is unlocked

Attachments [H| Nuxeo Studio Feature Overview.pdf (994 kE}
Associated tags

Common metadata & studio
@Add tags

Subjects

Rights

Source

Coverage
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1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

3. Fill in the document's creation form.
4. Click on the Create button.

H Available document types @ :
: Select the type of your new document in the list below. :
i Document Collaborative Services
; i Picture Folder Forum
i File . Blog site Email folder H
: , Note Workspace PictureBook :
: Ved . a -] :
: % WebSite T E
i Iq i

@ You can also create a file using the Import a file button or using drag and drop.

When the file is created, users can enhance it by filling its metadata, adding attached files on it, annotating it. When the document is completed,
you can publish it in one or several section(s).

Folders

In workspaces, you can create and manage your documents in folders.
A folder works like a workspace, but the documents available for creation are limited. In a folder, you can create:

® notes
* files
® sub-folders.

There are two types of folders in Nuxeo DM:

® regular folders
® ordered folders.

The difference between the two folder types is the way content is sorted.

® |n aregular folder, documents are sorted on the title by default. You can change the sort criterion by clicking on the content table columns
title. You can thus sort them on their state, author, etc.

® In an ordered folder, you can change the order of documents manually. So, the orders in which documents are listed in the folder doesn't
depend on one of its properties (version, author, etc). When a document is created, it is added at the end of the list.

Regular folders

Regulars folders, called "Folders", have the same behaviour as workspaces. In a folder, you can:

create documents and do all the actions available on them (edit, approve, manage relations, etc)
manage access rights,

subscribe to and manage alerts,

manage the folder's trash.

Like in a workspace, you can use drag & drop to create content in a folder.

Ordered folders

Ordered folders are folders in which you can change the content's order.
An ordered folder has the same presentation as a regular folder, but it has some additional buttons below the content table:

Move up

Move down
Move to top
Move to bottom
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To change the content's order:

1. Select a document using the checkbox on the left.
The move buttons are available.

My project =

Content Edit Alerts History

New Iterns page: | 20 ':!
=] Title Modified Author Version State
O @ Functional specifications [ § 10/5/10 5:57 PM John Doe 1.0 Project
=] Metadata mapping & & 10/5/10 6:08 PM John Doe 1.1 Project
a | Graphic resources [ 10/5/10 5:57 PM John Doe Project
O @ Contract 7 g 10/5/10 5:58 PM John Doe 1.0  Project
O 2] Meeting reports 10/5/10 6:08 PM John Doe Project
M [ Projectteam 10/5/10 6:09 PM John Doe 1.0 Project
Paste Add 1o worklist Copy Delete
Maove to bottom Move down Move to top Move up

2. Click on the move button you need.
3. The document is moved in the list of documents available in the folder.

My project =

m Edit Alerts History

New Items/page: | 20 ':]
a Title Modified Author Version State
® [of Projectteamp 10/5/10 6:09 PM John Doe 1.0 Project
O @ Functional specifications &7 @ 10/5/10 5:57 PM John Doe 1.0  Project
=] @_] Metadata mapping " & % Document moved to top |JI John Doe L1 Project
8 ||  Graphic resources [] 10/5/10 5:57 PM John Doe Project
O @] Contacti & 10/5/10 5:58 PM John Doe 1.0 Project
(] [E2  Meeting reports 10/5/10 6:08 PM John Doe Project
Paste Add to worklist Copy Delete
Move to bottom Move down Move to top Move up

@ You can move one document at a time. If you select more than one document, the move buttons will desactivate.

Working using drag and drop

Nuxeo proposes an extension to enable drag and drop in Nuxeo DM. Extensions are available for FireFox and Internet Explorer.
Nuxeo D&D extension enables you to:

® import documents or folders using drag and drop
® moving documents in Nuxeo DM
® publish documents in Nuxeo DM.

The extensions are available for download on the authentication page of Nuxeo DM.
You can also find links for older versions of the extensions here.

Supported browser versions are listed below:

® FireFox 2 and later,
® |nternet Explorer 6.0 and later.

Install Drag and Drop extensions

Drag and Drop extensions are available for the two officially supported browsers: FireFox and Internet Explorer.

Install FireFox extension

The Nuxeo D&D extention for FireFox is available on the login page of Nuxeo DM.
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Improve your experience

To improve your user experience, you may download:
The Internet Explorer Extension

The Firefox Extension

The Nuxeo LiveEdit plugin for M5 Office

It comes as a standard FireFox add-on. Installing process is the same as the other available FireFox add-ons : click on the link on login page and
follow the instructions.

Install Internet Explorer extension

To make drag and drop available on Internet Explorer, you need to install the Internet Explorer extension available from the login page of Nuxeo
DM.

Improve your experience

To improve your user experience, you may download:
The Internet Explorer Extension

The Firefox Extension

The Nuxeo LiveEdit plugin for M5 Office

The extension is available in 2 formats:

® _exe: includes the drag and drop package and the needed dependencies
® .msi: includes only the drag and drop package

To install the Internet Explorer extension, click on the link on login page and follow the instructions of the installer.

Importing content using Drag and Drop

You can use Drag and Drop to easily import content into Nuxeo DM or just to create one document at a time.

To import content into Nuxeo DM, drag an item (file or folder) from your computer and drop it into a workspace. The document is then
automatically created in the workspace and its title is the name of the original file or folder.

You can drag and drop files (one or more at a time) or folders with multiple files in Nuxeo DM. The complete struture of the dropped folder is
reproduced and created in Nuxeo DM.

Processing file 7/20

Loading

ciosa

You can drop any file type in Nuxeo DM. Here are some examples of most commonly used item types and their outpout in Nuxeo DM:

Item type Document created in Nuxeo DM
Folder Folder

Microsoft Office file File

OpenOffice.file File
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txt file Note

Picture (.jpg, .png, etc) Picture

Desktop & Office Suites Integration

To ease office documents integration, Nuxeo DM proposes two ways to create and edit document from their native application.

®* Nuxeo Live Edit enables you to create and edit office documents in their native application from Nuxeo DM. Nuxeo Live Edit is available
as an extension to be installed on the user's computer. It is available from Microsoft Office and OpenOffice.org.

® Nuxeo WSS enables you to work on Nuxeo's documents from your desktop directly. Nuxeo WSS is available for Microsoft Office only
and doesn't require any installation on the user's computer.

(D Extensions are available from the authentication page of Nuxeo DM.

Working with Live Edit

Nuxeo Live Edit is a Nuxeo DM extension that enables users to open Microsoft Office and OpenOffice.org documents in their native application
from Nuxeo. This extension prevents you from the painful process of downloadind - editing - uploading office documents in the application.

Live Edit comes as an extention that needs to be installed on the user's computer. It can be downloaded from Nuxeo DM's authentication page.

Improve your experience

To improve your User experience, you may download:
The Internet Explorer Extension

The Firefox Extension

The Muxeo LiveEdit plugin for MS Office

Live Edit is available for:

® MS Office
® OpenOffice.org

Live Edit allows you to:

® create documents in MS Office and OpenOffice.org
® edit documents in MS Office and OpenOffice.org

Create office documents
To create office documents directly into Nuxeo DM, follow the procedure below.

1. Click on one of the MS Office or OpenOffice.org icon displayed below the search box.
2. The application corresponding to the icon you clicked on opens.
3. Type the content of your document.
4. Save your modifications in Nuxeo DM:

® By closing the application.

® By cliking Save in Nuxeo in the Add-Ins menu of the application.

A Save in Nuxeo window opens.
5. Give the document a title and a description, and select where to save the document in Nuxeo DM.
6. Click on OK button.
The document is automatically saved in Nuxeo DM.

Edit documents

Documents that can be edited with Live Edit are indicated by the icon in the Content tab of the parent folder and in the Summary tab of the
document.

When you edit a document online using Live Edit, the document is automatically locked in Nuxeo DM. It is automatically unlocked when you close
the file from Microsoft Office or OpenOffice.org.
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: 1. Click on the online edition icon of the document. :
; The document opens in the appropriate application. :
: 2. Modify the file. :
3. When done, close the editing application.
: A window pops up. :
4. Indicate if you want to save the modifications.

Installing Live Edit

Live Edit works with Microsoft Office and OpenOffice.org. It is available for Internet Explorer and FireFox browsers. The table below summarizes
the extensions and packages you need to install for each OS and browser.

Internet Explorer FireFox
Microsoft Office Live Edit MS Office-IE (.msi) Live Edit MS Office-IE (.msi)
FireFox Protocol Handler
OpenOffice.org Live Edit MS Office-IE (.msi) Live Edit OpenOffice.org extension (.otx)
Live Edit OOo-IE (.exe) FireFox Protocol Handler

Below are the instructions to install Live Edit:

® for MS Office and Internet Explorer users,

¢ for MS Office and Firefox users,

¢ for OpenOffice.org and Internet Explorer users,
¢ for OpenOffice.org and Firefox users.

For MS Office and Internet Explorer users
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1. Run the Live Edit installer and follow the instructions.
2. If your are using Internet Explorer, close all windows and restart it.
3. Go on your Nuxeo application.
You now have new icons displayed:
® MS Office icons below the search box

Advanced search

2O =HE&

® an online editing icon in the workspace listing for MS office documents

Functional documentation =

m Edit Alerts History Manage

MNew Import a file

¥l Title ¢ Modified Author Version State
Il @ Muxeo DAM L.1 User Guide &' & 10/21/10 6:58 PM John Doe 1.1 Froject
Fl @ Nuxeo DM 5.3.2 User Guide &' § 11/3/10 12:17 PM John Doe 1.2 Project
O @ Nuxeo DM Install Guide &' & 10/18/10 10:48 &AM Administrator 1.1 Froject

® an online editing icon in the Summary tab of MS office documents
Nuxeo DM 5.3.2 User Guide =

User guide of version 5.3.2 of Nuxeo Document Management
Edit Files Publish Relations Workflow Alerts Comments History Preview Manage

Content State Project Version 1.2

Main File @ Nx-5-3-2-UserGuide.doc (26 kB) & ﬁ This document is unlocked | Lock

Description

Associated tags
User guide of wersion 5.3.2 of Nuxeo Document Management

@Add tags
Common metadata

You can now edit documents online.

For MS Office and FF users

Making LiveEdit work for MS Office documents when you use FireFox takes 3 steps:

1. Install Live Edit for MS Office,
2. Install the FireFox extension for Live Edit, called protocal handler,
3. Configure the FireFox protocol handler.

Install Live Edit for MS Office

You need to install Live Edit for Microsoft Office using the same installer as for MS Office and Internet Explorer: just run the installer and follow the
instructions displayed.
At the end of this step, you won't see the online editing icons, because you need to install and configure the FireFox protocol handler.

Install Firefox Protol Handler

The Firefox Live Edit extension is a regular Firefox extension and gets installed the same way as any other extension on that browser.

To install it, click on the link to download it and follow the instructions displayed.

At this stage, you still won't see the online editing icons in Nuxeo DM. To see the icons and be able to edit documents, you need ton configure the
protocol handler.

Configure the Firefox protocol handler
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To configure Live Edit Firefox Protocol Handler:

In Firefox, go to Tools > Add-ons > Nuxeo Live Edit Protocol Handler > Preferences (or Options).

Change the temp folder : / t np/ with C: \ Tenp (or another temp folder like C: \ W ndows\ Tenp)

Set the mime-types you want to use Live Edit with and click on Add new mapping (see below for the mimetypes mapping).
Be sure that the checkbox "Use NXWss" is un-checked.

Be sure to check correctly "Preserve compatibility".

arwNdE

1 Since version 0.4.6 of the protocol handler, there is a checkbox labeled "Preserve compatibility” that allows to
* preserve the backward compatibility.
This box must be checked when the targeted server is pre 5.2.
Without checking it, the addon is forming a different type of headers allowing using of a bunch of new features
like WebEngine (but it works only for the server 5.2 +). Simple said:

® if Live Edit appear not to work (there is no available Edit online link) and the targeted Nuxeo server is not
5.2 or higher, check that the "Preserve compatibility" is marked.

® if some cool features like WebEngine are not available (throwing exception) and the targeted Nuxeo
server is 5.2 or higher, check that the "Preserve compatibility” is not marked.

6. Click Ok.

MS Office mimetype mapping with MS Office

File extension

.doc

Xls

.ppt

.docx

Xlsx

Mimetype Editor command Editor command arguments

appl i cation/ msword C:.\ Program %s
Fi | es\ Nuxeo\ Nuxeo Live

Edit MsOfice

| E\ nuxeo-liveedit-nsoffi

ce-l auncher. exe

appl i cation/vnd. ns- excel C:\ Program Y%s
Fi | es\ Nuxeo\ Nuxeo Live

Edit MsOfice

| E\ nuxeo- | iveedit-nsoffi

ce- |l auncher. exe

appl i cation/vnd. ms- power C:\ Program Y%s
poi nt Fi | es\ Nuxeo\ Nuxeo Live

Edit MsOffice

| E\ nuxeo- | i veedit-nsof fi

ce-l auncher. exe

appl i cati on/ vnd. openxmn f C:.\ Program %
or mat s- of fi cedocunent . wo Fi | es\ Nuxeo\ Nuxeo Live
rdprocessi ngm . docunent Edit MsOFfice

| E\ nuxeo-1iveedit-nsoffi

ce-l auncher. exe

.pptx

appl i cation/vnd. openxm f
ormat s- of fi cedocunent . sp
readsheet m . sheet

appl i cation/vnd. openxm f
ormat s- of fi cedocunent . pr
esentationm . presentatio
n

For OpenOffice.org and IE users

C:.\ Program %

Fi | es\ Nuxeo\ Nuxeo Live
Edit MsOffice

| E\ nuxeo-|iveedit-nsoffi
ce-l auncher. exe

C:\ Program

Fi | es\ Nuxeo\ Nuxeo Live
Edit MsOFfice

| E\ nuxeo-1iveedit-nsoffi
ce-l auncher. exe

To make Live Edit work when you use OpenOffice.org and Internet Explorer, you need to:

1. install the MS Office - IE Live Edit (see #LiveEdit-MSO-IE-forFF)

2. install the OpenOffice.org - |IE Live Edit extension

This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page.
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1. Run the OpenOffice.org - |IE Live Edit installer (.exe) and follow the instructions displayed.
2. Restart Internet Explorer if you have windows open.
3. Go on your Nuxeo application.
You now have new icons displayed:
® MS Office and OpenOffice.org icons below the search box

Advanced search

IEEEEE 238

® an online editing icon in the workspace listing for MS office and OpenOffice.org documents

Functional documentation =
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MNew Import a file

¥l Title ¢ Modified Author Version State
Il @ Muxeo DAM L.1 User Guide &' & 10/21/10 6:58 PM John Doe 1.1 Froject
Fl @ Nuxeo DM 5.3.2 User Guide &' § 11/3/10 12:17 PM John Doe 1.2 Project
O @ Nuxeo DM Install Guide &' & 10/18/10 10:48 &AM Administrator 1.1 Froject

® an online editing icon in the Summary tab of MS office and OpenOffice.org documents

Functional documentation =

m Edit Alerts History Manage

MNew Import a file

¥l Title ¢ Modified Author Version State
Il @ Muxeo DAM L.1 User Guide &' & 10/21/10 6:58 PM John Doe 1.1 Froject
Fl @ Nuxeo DM 5.3.2 User Guide &' § 11/3/10 12:17 PM John Doe 1.2 Project
O @ Nuxeo DM Install Guide &' & 10/18/10 10:48 &AM Administrator 1.1 Froject

You can now edit documents online.

For OpenOffice.org and Firefox users
To be able to edit OpenOffice.org documents online using Firefox, you need to:

1. install the Live Edit OpenOffice.org extension (.otx),
2. install the Firefox protocol handler,
3. configure the Firefox protocol handler.

Install the Live Edit OpenOffice.org extension

The Live Edit extension for OpenOffice.org is a regular OO0 extension and gets installed the same way as any other extension: just double-click
the .otx file and follow the instructions.

Then you need to install and configure the Firefox extension.

Install Firefox Protol Handler

The Firefox Live Edit extension is a regular Firefox extension and gets installed the same way as any other extension on that browser.

To install it, click on the link to download it and follow the instructions displayed.

At this stage, you still won't see the online editing icons in Nuxeo DM. To see the icons and be able to edit documents, you need ton configure the
protocol handler.

Configure the Firefox protocol handler
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1. In Firefox, go to Tools > Add-ons > Nuxeo Live Edit Protocol Handler > Preferences (or Options).

2. Change the temp folder : / t np/ with C: \ Tenp (or another temp folder like C: \ W ndows\ Tenp)

3. Set the mime-types you want to use Live Edit with and click on Add new mapping (see below for the mimetypes mapping).
4. Be sure that the checkbox "Use NXWss" is un-checked.

5. Be sure to check correctly "Preserve compatibility".

1 Since version 0.4.6 of the protocol handler, there is a checkbox labeled "Preserve compatibility” that allows to
* preserve the backward compatibility.
This box must be checked when the targeted server is pre 5.2. :
Without checking it, the addon is forming a different type of headers allowing using of a bunch of new features :
like WebEngine (but it works only for the server 5.2 +). Simple said: :

® if Live Edit appear not to work (there is no available Edit online link) and the targeted Nuxeo server is not
5.2 or higher, check that the "Preserve compatibility" is marked.

® if some cool features like WebEngine are not available (throwing exception) and the targeted Nuxeo
server is 5.2 or higher, check that the "Preserve compatibility” is not marked.

6. Click Ok.

OpenOffice.org and MS Office mimetype mapping with OpenOffice.org

File extension Mimetype Editor command Editor command arguments
.doc appl i cation/ msword C:.\ Program macro:///LiveEditQO0o. | au
Fil es\OpenOifice.org ncher .| oad( %)
3\ program soffice. exe
Xls appl i cation/vnd. ns- excel C:\ Program macro:///LiveEdit Q0. | au
Fil es\OpenOifice.org ncher .| oad( %)
3\ program soffice. exe
.odt application/vnd.oasis.op C\Program macro:///LiveEditOOo. | au
endocunent . t ext Fi |l es\ OpenOffice.org ncher. | oad( %)
3\ program sof fice. exe
.ods application/vnd.oasis.op C:\Program macro:///LiveEditQ0o. | au
endocunent . spreadsheet Fil es\OpenOifice.org ncher .| oad( %)
3\ program soffice. exe
.odp application/vnd.oasis.op C:\Program macro:///LiveEdit Q0. | au
endocumnent . presentati on Fil es\OpenOifice.org ncher .| oad( %)

3\ program soffice. exe

Live Edit OpenOffice.org is not compatible with MS Office 2007 documents yet.

Working with WSS

Nuxeo DM supports the Windows SharePoint Service (WSS) protocol and thus enables you to create and edit MS Office documents stored in
Nuxeo DM directly from Windows Desktop, without having to go on your Nuxeo DM application at all.

Nuxeo WSS doesn't require any plugin installation or configuration on Nuxeo side or Windows side.

Using WSS, you will be able to do the following actions on Nuxeo MS Office documents, from Windows directly:

create documents and folders,
edit documents,
move documents and folders,
access some document management informations from Nuxeo:
® relations on the document,
® contributors of the document,
® workflow tasks on the document,
® other documents in the same folder.

Edit documents

1. Open the document's native application.
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2. Click Open.
3. In File name, type the address of your Nuxeo DM application.
4. Make sur All documents is selected in the *Files of type" list.
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@ If you already connected to your Nuxeo DM application from Windows directly, you can find it in My network
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5. Click on the Open button.
A connect window opens.
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6. Type your login and your password and click on the OK button.
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7. Navigate in the application's content to your document and open it.
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The document is automatically locked in Nuxeo DM.
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8. Edit the document.
9. Save the modifications.
Modifications are saved in Nuxeo DM directly.
10. When done, close the document.
The document is unlocked in Nuxeo DM.

Consult the information on the document
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Nuxeo WSS gets some informations from Nuxeo that you can consult directly from MS Office as you edit the document.
These information are :

® the contributors of the document,
® the relations on the document,
® the workflow tasks pending on the document.
You can also see and open the other documents in the same folder.

To see more document management information on the document:

1. In the MS Office application, open the Document Management panel from Windows menu > Server > Document
Management Information.
A new panel opens.

2. Click on each of the tabs to see the different informations on the document.
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Create content in Nuxeo from Windows

You can create folders and documents in Nuxeo from your Windows desktop.
The SharePoint integration in Nuxeo DM enables your nuxeo DM application to be recognized as a Network place by Windows.
@ If you edited a document using WSS, your application is already available in the network places.

If you haven't connected to your nuxeo DM application from Windows yet, use Windows Add a new network place feature to add your
application in the network places.

You can then create, copy and move documents and folders in Nuxeo DM via the Windows Explorer the same way you would do in a local folder
like My Documents.
To create documents in a Nuxeo folder or workspace, you can:

® drag and drop files from a local Windows folder into the target Nuxeo folder in Windows Explorer
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Relations

Relations are informations that connect the application's documents with other documents or external resources. Documents are thus part of a
coherent and organized structure.

A summary of the document's relations is displayed in the Summary tab.
Nuxeo 5.3 User Guide &

Edit Files Publish Relations Workflow My subscriptions Comments History Preview

Content State Project Version 11

Main File Nx-5-3-UserGuide.doc (26 kB} 3 This document is unlocked | Lock

Common metadata

Associated tags

Subjects @Md tags

Rights

Source Relations

Coverage This Document ...

Created at 4/27/10 6:36 PM

Last modified at 4/27/106:37 PM Replaces B Nuxeo 5.2 User Guide
Format

You can also see all the document's relations in the Relations tab of the document. In Relations tab, relations are sorted by outgoing and
incoming relations. Outgoing relations are relations that were created from the current document. Incoming relations are relations which were
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created from another document and to the current document.
The objects of the relation are hyperlinks. Click on the object's name to consult it.

Available relations are:

reference relation (references, is referenced by),
basis relation (is based on, is base for),
replacement relation (replaces, is replaced by),
requirement relation (requires, is required by),
compliance relation (conforms to, has conform).

Add arelation

You need to have writing or management rights to add relations on a document.
You can create a relation from a document to:

¢ another document on the application,
® an external document (using URI),
* atext.

You can create relations between documents from different workspaces or domains.

When you add a relation on a document, it creates what we call an "outgoing" relation. The document to which you added the relation
automatically has an "incoming" relation.

1. Click on the Relations tab of the document.
2. Click on the Add a new relation link.
The relation creation form is displayed under the link.

Add a new relation

B

Predicate * Select a value

— Text

N -
Object — Resource URI

— Document Search
Comment

Add

3. Fill in the relation creation form.
4. Click on the Add button.

The relation is displayed as an outgoing relation, under the relation creation form.
Outgoing relations

Predicate Object Creation Author Comment Operations
Replaces NUXeo 5.2 4/27/10 B39 PM jdoe Update for Nuxeo 5.3 release Delete
User Guide

An incoming relation is automatically created in the target document's Relations tab, that directs to the source document of
the relation.

Incoming relations

Predicate Object Creation Author Comment
Is replaced by Nuxeo 5.3 4727710 6:39 PM jdoe Update for Nuxeo 5.3 release
User Guide

Relations are also displayed in the Summary tab of the document.
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Delete a relation

You need to have writing or management rights to delete the relations of a document.

You can delete outgoing relations only.

1. Click on the Relations tab of the document.
; 2. Click on the Delete link corresponding to the relation. :
! The relation is deleted and does not appear in the table anymore. It is also removed from the incoming relations of the H

Comments

You can add comments on the documents, via the Comments tab. Comments enable users to discuss about the document and its evolution.
Comments are attached to the document in the workspace. When the document is published, comments are not published with it.

All users can see the comments added on a document.

Add a comment on a document

You need reading rights to add comments on documents.

1. Click on the Comments tab of the document.
2. Click on the Add a comment link.
A form to add a comment is displayed.

Nuxeo DM 5.3.2 User Guide =

User guide of version 5.3.2 of Nuxeo Document Management

Summary Publish Relations Workflow Alerts Comments History Preview

= Add a comment

Cancel Add

3. In the text area, type your comment.
4. Click on the Add button.
The comment is displayed in the Comments tab. Users can now reply to your comment.

Nuxeo DM 5.3.2 User Guide =

User guide of version 5.3.2 of Nuxeo Document Management

Summary Publish Relations Workflow Alerts History Preview

HAdd a comment

(I John Smith 10/1/10 2:24 PM Reply | Delete

Section 3.2.1 should be updated with the new features of 5.3.2.

Reply to a comment

You need to have reading rights to reply to comments on documents.

When you want to react to a comment, you can reply to it. Answers are inserted right after the comment they reply to, making it easy to read the
thread of discussion.
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1. Click on the Reply link on the comment.
A form is displayed under the comment.

Nuxeo DM 5.3.2 User Guide =

User guide of version 5.3.2 of Nuxeo Document Management

Summary Edit Files Publish Relations Workflow Alerts History Preview

©“Add a comment

) John Smith 10/1/10 2:24 PM Reply |

Section 3.2.1 should be updated with the new features of 5.3.2.

Cancel Add

2. Type your comment in the text area.
3. Click on the Add button.
The answer is inserted after the comment it replies to.

Nuxeo DM 5.3.2 User Guide =

User guide of version 5.3.2 of Nuxeo Document Management

Summary Edit Files Publish Relations Workflow Alerts History Preview

L Add a comment

(5 John Smith 10/1/10 2:24 PM Reply |

Section 3.2.1 should be updated with the new features of 5.3.2.

1) John Doe 10/1/10 2:27 PM Reply | Delete

Section has been updated. Thanks for reporting this :)

Delete comments

Only the author of the comment and users with management rights can delete the comments of a document.

{D Deleting a comment is a permanent action. You cannot restore deleted comments.

1. Click on the Comments tab of the document.
2. Click on the Delete link displayed in the top right corner of the comment.

(2} John Smith 10/1/10 2:37 PM Reply | Delete

Section's updated

The comment is immediately erased.

Annotations

Annotations are post-its or comments placed on the preview of documents.
You can annotate documents as soon as you can access them, ie when you have at least "Read" right.
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1. Click on the Preview tab of the document.
The document's preview is displayed.

2. Draw a frame on the preview.
An input pop up appears.

3. Type your comment.
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i 4. Click on "Submit".

The annotation is saved.

; You can see your annotation when the mouse is over the zone you selected, and, in the margin, the list of annotations, and
for each, the author, date and time of annotation and the text.
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Tags

Tags are labels that you can add on documents to help you describe them.

Unlike subjects in the metadata of the document, you don't have to choose tags in a closed list. You are free to apply the labels that describe the
document best. However, tags are proposed as you type them, to enable you to use the same tags as the other users and have a consistent
tagging of documents.

You can add as many tags on documents as you want.

Nuxeo 5.3 User Guide #

The user guide of Nuxeo DM 5.3

m Edit Files Publish Relations Workflow My subscriptions Comments History Preview

Content State Project Version 11

Main File | Nx-5-3-UserGuide.doc (26 kB) E3 This document is unlocked | Lock

Description
Associated tags

The user guide of Nuxeo DM 5.3

)53 @
Common metadata & user guide @
O documentation @
Subjects O dm @
Rights Dadd tags
Source Add tags
Coverage

You can then use the tag cloud to find all documents that have the same tags.
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| @ [

5.3 studio planning ep dam
documentation screencast
screenshots ecm architecture

dm 5.2 website user guide
marketing

Tag documents

Users can add a tag on a document as soon as they can access the document, ie as soon as they have reading rights.

Documents can be tagged in workspaces and in sections. When a document is published, the tags applied in the workspaces are not published
with the document. You can have tags in the workspace that are more collaborative work oriented than in the section.

1. Go on the Summary tab of the document.
2. Click on the Add tags link.

A text area is displayed below the link.
3. Type a label.

@ Tags already used are proposed from 3 letters typed.

Associated tags

4 5.3 ]
</ user guide @
¢/ documentation (@
< dm @
@Addtags

scre| Add tags

</ screencast

</ screenshols -

4. Click the button Add tags button.
The tags are immedialtely available in the tag cloud.

Remove tags

You need to be the user who added the tag on the document or have at least write right on the document to be able to remove a tag from a
document.

To remove a tag from a document, click on the icon @'.
The tag is immediately removed.

Document's history

All the actions that are done on the document are registered in the document's history, with several informations, such as the date and time, the
user, the comment, etc.

Event log

Performed action Date Time Username Category Comment State
Unlock document 11/06/09 17:29 John Doe Decument Project
Modification 11/06/09 17:29 John Doe Document Updated document structure Project
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To consult the document's history, click on the History tab.

The History tab also displays the previous versions of the document that were archived when the document was edited and its version increased.
All previous versions can be consulted. You can also restore or delete versions.

Viewing a previous version of a document

All users can consult the previous versions of a document.

Every time you modify a document, the previous version is automatically archived by the system. Thus, the modifications do not erase the original
version of the document.

The archived versions are listed below the Event log in the History tab.

Archived versions

Version Action

1.0 View archived version
2.0 Wiew archived version
2.1 View archived version
2.2 Wiew archived version

To consult a previous version of a document, click on the View archived version button corresponding to the chosen version. The archived
version opens.

Archived versions have few actions available: you can only create relations from it to another document, annotate it and subscribe to notifications.

Restoring a older version of a document

You need to have writing or management rights to restore a previous version of a document.

Restoring an archived version means making it the current version of the document. The modifications done since that old version are thus not
taken into account anymore.

To restore an archived version, click on the Restore button corresponding to the chosen version. The document is displayed as it was for the
chosen version.

Archived versions

Version Action

1.0 Restore Wiew archived version Delete
2.0 Restore Wiew archived version Delete
2.1 Restore Wiew archived version Delete
2.2 Restore Wiew archived version Delete

Deleting a older version of a document

You need to have writing or management rights to delete a previous version of a document.

| Lot
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L2 version deletion is a permanent action.

To delete an archived version, click on the Delete button corresponding to the chosen version. The version is immediately and permanently
deleted.

Alerts

Nuxeo DM includes several ways to stay informed of the evolution of the documents.
You can set alerts for yourself and you can also set alerts for other users.

To be informed of content modifications, you can subscribe to email notifications or feeds.
To keep other users notified of the space activity, you can set alerts for users or groups of users so they are automatically informed or send them
occasional emails.

Sending an email

You can send occasional emails to users, to draw their attention on the document. Emails are available on documents only.

You need to have at least reading rights to send emails.

1. On the document, click on the envelope icon, located at the right of the breadcrumb trail section, next to the Print icon.
The email creation form is displayed.

2. Type the name of the user or group you want to send the email to, in the search box.
The search is automatically done as you type the name of the user or group.

Add New User

Search | | atu

Users
Type Username Action
E\ aturing (Alan Turing) Add to selection

Selected Users

Your user selection is empty

3. Click on the Add to selection link corresponding to the users or groups whose subscriptions you want to manage.
They are displayed in your selection.

Add New User

Search |, atu

Users
Type Username Action
/E\. aturing (Alan Turing) Add to selection
Selected Users
Username Action
aturing Remove from selection

Empty the selection
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4. Type the subject and the content of your email.

Subject Impaortant modifications
Hi !
I've made important modifications on the decument's structure. Can you take a look before next meeting?

Thanks!

B 7 U aec | == = | -- Stylas - || Paragraph =
TS| EE |9 | b E S @
—CHE| % * |2 =%

Send

5. Click on the Send button.
The email is send to the selected users or groups. The Summary tab of the document is displayed.

r________________________________________________________________________________________________________________________________

Setting automatic notifications

Notifications are emails automatically sent to users when an event occurs in a space. Notifications are available in every space of the application
and on documents. Users can subscribe to notifications and spaces' managers can subscribe users to notifications.

There are six notifications:

® creation: the user gets an email when some content is created in the space;

® modification: the user receives an email every time the space or its content is edited,;

® workflow changed: the user receives an email for each action that happens during a review (start, abandon, document approval,
document rejection);

® Approval workflow started: the user receives an email every time an approval workflow is started;

® Comments moderation: the user receives an email when a comment is approved on a site.

® publish: the user receives an email when a document is published in the specified section.

@ Publish notification is available in sections only. The other notifications are available in workspaces only.

Subscribing to notifications

You need to have at least reading rights to subscribe to notifications.
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1. In the space, click on the My Subscriptions tab.
2. Click on the Subscribe button corresponding to the notification you want to subscribe to.

Available subscriptions

' Comments mederation Subscribe
' Modification Subscribe
' Creation Subscribe
o Waorkflow changed Subscribe
o Approval workflow started Subscribe

A green check mark is displayed in front of the notification you have subscribed to and an Unsubscribe button is displayed
instead of the Subscribe button.

Available subscriptions

> Comments moderation Subscribe
« Modification Unsubscribe
o Creation Subscribe
o Workflow changed Subscribe
o Approval workflow started Subscribe

If the workspace or section manager subscribed you to a notification, the notification is already checked.
The natifications subscribed for a group are indicated in the My Subscriptions tab of users as inherited subscriptions.
Inherited subscriptions

4 Modification

Unsubscribing from notifications

You need to have at least reading rights to unsubscribe from notifications.

@ You cannot unsubscribe from notifications subscribed for your group.
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1.
2.

In the space, click on the My Subscriptions tab.

Click on the Unsubscribe button corresponding to the notification you want to unsubscribe from.

Available subscriptions

o Comments moderation

« Modification

Subscribe

Unsubscribe

o Creation Subscribe
o Workflow changed Subscribe
o Approval workflow started Subscribe
A button Subscribe is displayed instead of the Unsubscribe button.
Available subscriptions
o Comments moderation Subscribe
o Modification Subscribe
O Creation Subscribe
o Workflow changed Subscribe
o Approval workflow started Subscribe

Managing subscriptions

Only users with management rights can manage the users' subscriptions.

Users with management rights can see the subscriptions users have signed up to. They can also subscribe users or groups to subscriptions or
unsubscribe them.

. In the space, click on the Manage tab.

. Click on the Subscriptions sub-tab.

The lists of users subscribed to each notification type is displayed above a subscription form.
. Type the name of a user or a group in the search box.

Search for users or groups

atuf

- st 3 character(s)
iZ»Alan Turing

Action

Motification
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4. Click on the user or group you want to subscribe to a notification.
The user or group is displayed on the right of the search box.

Search for users or groups

[

To start the search, please type at least 3 character(s)

Action Subscribe | ¥ l
Motification Maodification | v
Register

2, alan Turing

5. Select the action you want to do (Subscribe or Unsubscribe) and the natification concerned.
6. Click on the Register button.
The modifications are displayed in the list of subscriptions.

Modification

£ Alan Turing

search for users or groups

To start the search, please type at least 3 character(s)

Action Subscribe | : l

Motification Modification s

Register

Workflows

All the documents evolve according to a defined life cycle. This life cycle is composed of the following states: project, approved, obsolete and

deleted. To change the document's life cycle state, you have to submit it to a workflow.
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Workflow / Edit
MO0,

Obsolete Deleted

Workflow / Deletion

Workflow / Deletion

A workflow is a process in which a chain of users is defined to review and approve or reject the document.

When a document is submitted to a workflow, the users who participate to the workflow have an indication of what they need to do on the
document. This is the directive. The workflow is automatically ended when all participants have reviewed the document. Then, the document
moves into the pre-defined life cycle state.

There are two types of workflow:

® parallel workflow,
® approval workflow.

The difference between the two workflows is the participation order. In a parallel workflow, all users can review the document as soon as the
workflow is started. An approval worflow, on the other hand, is an ordered workflow. This means that participants can review the document only
when the previous participant in the list has approved the document.

Users who are involved in workflows are alerted by email and can have a synthetic view of all the tasks they have to do on documents in their das
hboard. The documents they have to review are listed there.
Start a workflow

You need to have writing or management rights to start a workflow.

@ The process to start a workflow is the same for both workflows.
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1. Click on the Workflow tab of the document.
2. Fillin the form Start a workflow: select the type of workflow you want to start and the output life cycle state.
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4. Add users on the workflow.
@ You are not automatically declared as a participant of the workflow. If you want to participate to the workflow, you
need to add yourself as a participant.

5. Click on the Start the workflow button to let participants approve or reject the document.

3. Click on the Start button.

Manage workflow participants

When you prepare a workflow, you determine which users will review the document.
Given the workflow type and your participation to the workflow, you can add new participants, change their order of participation, or remove them.
To make recurrent participants management easier, you can also use reviewers lists.

Add participants to a workflow

Only the workflow initiator and administrators can add users on a workflow.

Approval workflow participants can also add new users when they are the current reviewer of the document. As soon as they approved it, they
cannot manage the workflow participants anymore.
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1. Onthe Workflow tab, in the Select reviewers form, type the name of a user or a group.
The users and groups corresponding to the letters typed are displayed.
|

e =
[
----- bt e
[N P—
s e S
e i
e b
Brven

2. Click on the user you want to add on the workflow.
. Fill in the other fields of the form.
4. Click on the Add button.
The new participant is added below the current participant.

w

Workflow
Approved Name Directive Comment Start date End date Due date
@ @ 5 John Doe WValidation Can you take a quick lock? 17-Jun-2009 10:16:00

@ You can also load a reviewers list.

Manage reviewers lists

You can save the lists of workflow participants, to reuse them later on the same type of workflow. Indeed, documents often go through the same
chains for review or approval.

Workflow participants lists are saved by user and by workflow type. This means that users can only see the lists they saved, not the list other
users saved. And that a list can only be used on the same workflow type as the workflow it was saved from.

Save a list
Any user can save a workflow participants list.

1. Go on the Workflow tab of the document.
2. In the Workflow section, type a name for the list.

3. Click on the Save the list button.
The list is saved and is now available in the Select reviewers form.
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Approved Name Directive Comment Start date End date Due date i
i

@ o £ John Doe Check Can you check it? May 28, 2010 10:23:00 AM .
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Load a list

You can load a list of participants at any time, as long as you have the right to add reviewers on the workflow. You can also combine the use of a
list and the manual management of participants (move, add, remove).
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To load a list:

FTT 1. Select it in the Load a list of reviewers drop down list in the select reviewers form. 7 :

i [— T - R i

i T ;

2. Clickontheloadbutton.
Delete a list

You can delete the lists of reviewers you have saved from a workflow.

1. Selectitinthe Load a list of reviewers drop down list in the select reviewers form.
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2. Click on the Delete button.

Move participants in the workflow

Users who can add participants to a workflow can also change their order on the workflow. Use the  and ¥ arrows to move users up and down
in the workflow.
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Remove participants

Users who can add participants to a workflow can also remove them from the workflow.

1. Click the icon @ to remove from the workflow.
2. Confirm removal on the window that pops up.
Users is immediately removed from the participants of the workflow.

Participate to a workflow

Once the workflow has been started, users added on the workflow's roadmap can review the document and approve or reject it.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 50


http://doc.nuxeo.com/x/GATF

NU32Ze O Nuxeo Document Management 5.3 Documentation Center

s e e e
" - e wy .

- -

1] -

@ The workflow initiator can approve or reject the document in behalf of all the workflow's participants.

Approve a document

In a parallel workflow, participants can approve the document as soon as the workflow is started.
In an approval workflow, participants can approve the document when it's their turn, after the previous participant on the workflow has approved it.

Click on the Approve link displayed on the workflow's roadmap next to your name.
A green tick on the roadmap indicates that you approved the document.
If you are in an approval workflow, the next participant can now review the document and approve or reject it.

Arkiea

Reject a document

In a parallel workflow, participants can review the document and reject it as soon as the workflow is started.
In an approval workflow, participants can reject the document when it's their turn, after the previous participant on the workflow has approved it.

1. Type a comment to indicate why you reject the document (mandatory).

2. Click on the Reject link displayed on the workflow's roadmap next to your name.
A red tick on the roadmap indicates that you rejected the document.
If you are in an approval workflow, the previous user on the roadmap is automatically inserted after you on the roadmap to
check the document. His directive is "Verification after reject".
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End the workflow
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The workflow will automatically ends when the last reviewer approves or rejects the document.
In a parallel workflow:

® |f all participants have approved the document, its lifecycle state changes into the one chosen when before the workflow was started.
® |f a user has rejected the document, the workflow ends but its lifecycle state doesn't change.

In an approval workflow, all users must approve the document. The document will then automatically get into the target lifecycle state.
Abandon a workflow

Only the workflow initiator and administrators can abandon a workflow.

Abandoning a workflow means canceling it. When you abandon a workflow, the life cycle state of the document does not change. The

modifications made on the document during the workflow are kept.

@ The abandon process is the same for the two types of workflows.

1. Click on the Workflow tab of the document.
2. In the Abandon workflow section of the page, type a comment in the Comment field.

Abandon workflow

Comment™

Abandon workflow

@ Comment is mandatory to abandon a workflow.

1. Click on the Abandon workflow button.
The workflow is canceled. The life cycle state of the document does not change and the modifications done during the
workflow are saved.

A forum is a discussion space in which users can talk together. A forum is organized around different topics, in which users can add comments.
Topics and comments are displayed in threads.

As for workspaces and sections, the access to a forum is defined by access rights. Forum access rights are the same as workspace access
rights. However, in the case of a moderated topic, some users are declared "moderators" and are in charge of the approval of the topic content.

Forum creation and edition are available for users with ‘Write' and 'Manage' rights.
Users with 'Manage' rights can also manage the forum like a workspace, ie give users access rights, set alerts and manage the forum's trash.

Create a forum

You need 'Write' or ‘Manage' rights to be able to create a forum.

You can create forums only in workspaces.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 52


http://doc.nuxeo.com/x/GATF
https://doc.nuxeo.com/display/DMDOC53/Manage+topics#Managetopics-topic-moderation

nuxeo

Ed

You

Nuxeo Document Management 5.3 Documentation Center

1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

Available document types
Select the type of your new document in the list below.
Document Collaborative Services
- Picture Folder
File . Blog Site
, Note Workspace
Ve -
b WebSite

Forum
Email folder

= PictureBook

3. Fill in the document's creation form.
4. Click on the Create button.

The forum is created. You can now create topics to start discussing.

Nuxeo Forum

Edit My subscriptions | History

@ Forum saved
New topic

This folder contains no document

it aforum

need 'Write' or 'Manage' rights to edit a forum.

When you edit a forum, you modify its title and its description.

1. On the forum, click on the Edit tab.

2. Modify the title or the description of the forum. You can also add a comment explaining what you edited on the forum.

3. Click on the Save button.
The modifications are saved and the Forum tab is displayed.

Manage topics

A topic can be moderated, that is to say that the content needs to be approved in order to be available to forum readers.

® |n an topic without moderation, the content is available without preliminary approval.

® In a moderated topic, the content needs to be approved by a moderator to be visible for users.

@ You are automatically added as a moderator if you create a moderated topic.

Ad

d atopic
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1. In the Forum tab of the forum, click on the New Topic button.
2. Type the topic's title and optionally add a description.
3. Select if the topic is moderated or not. If yes, search and select the moderators.
4. Click on the Create button.
The Topic tab of the topic is displayed, with the form to add a first comment on the topic.

Nuxeo features

My subscriptions

Add a comment

Title

Comment

Attach a file
) None

) Upload (Parcourir... )

Add Cancel

The list of the topics available in a forum is displayed in a table in the Forum tab.

Nuxeo Forum
Edit My subscriptions History
New topic

Topic Last message Nb. of published posts Nb. of pending posts Moderation

=
O Nuxeo features 0 1] No

Moderate a topic

When a user creates a topic, he or she decides if the topic is moderated or not. Moderation is a process that makes comments available to
moderators only when they are created, until they approve or reject the pending comments. Approval is thus mandatory to make comments
available for other forum users.

When a user creates a moderated topic, he appoints users to manage comments on the topic. Only these moderators can approve or reject
pending comments.

Moderators can see if there are comments pending in the forum tab. The number of comments waiting for approval is indicated for each topic of
the forum.

Nuxeo Forum

My subscriptions | History
O Topic Last message Nb. of published posts Nb. of pending posts Moderation
B Nuxeo features ] 1 Yes

Approve a comment

Approving a comment means to publish it in the thread and make it available for all forum users.
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i To approve a comment:

P 1. Open the topic that has pending comments. ;
: The pending comments have the status "Waiting for approval. :
i _) Welcome - by jdoe 19:37 { Waiting for approval ) Delete | Approve | Reject i
i Welcome on the Muxeo features topic! i
i Add E
2. Click on the Approve link in the top right corner of the pending comment.
: The comment's status is "Published". It is now available to all forum readers. :
i 2} Welcome - by jdoe 19:37 { Published ) Reply | Delete i
i Welcome on the Nuxeo features topic! E
i Add E

Reject a comment

Rejecting a comment means that you make the comment permanently unavailable for forum users.

1. Open the topic that has pending comments.
The pending comments have the status "Waiting for approval".

elcome - oe 7 { Published ) elet
Wel by jdoe 19:37 { Published Reply | Delete

Welcome on the Nuxeo features topic!

;) Re:Welcome - by jsmith 19:58 ( Waiting for approval } Delete | Approve | Reject

Thanks!

Add

2. Click on the Reject link in the top right corner of the pending comment.
The comment's status is "Rejected"”. It is now permanently unavailable.

_) Welcome - by jdoe 19:37 ( Published ) Reply | Delete

Welcome on the Nuxeo features topic!

NJ Re:Welcome - by jsmith 19:58 { Rejected ) Delete
Thanks!

Delete a comment

Only the comment's author and the topic moderators can delete comments.

2. Click on the Delete link located in the top right corner of the comment to delete.

1. Open the topic.
: The comment is immediately and permanently deleted.

Delete a topic

Deleting a topic means deleting its content as well.

When you delete a topic, it is definitively erased from the application.

| To delete a topic:

1. In the Forum tab of the forum, select the topic you want to delete by checking the corresponding box.

2. Click on the Delete button.

: A confirmation window pops up.

3. Click on the OK button.

: The topic is moved to the forum's trash. Users can then restore the topic into the forum or erase the same way as a
S documentinaworkspace.

Participate to a topic

To participate to a topic, you can add comments in it. The other users will be able to answer your comment.
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Add a comment to a topic

You must have at least writing rights to add comments on a topic.

Nuxeo Document Management 5.3 Documentation Center

You can attach a file to your comment, that users will be able to consult. The attached file of a comment cannot be modified or removed

afterwards.

1. Click on the Topic tab of the topic.

@ If the topic is empty, the form to add a comment is automatically displayed in the Topic tab.

2. Click on the Add button to display the form to add a comment.

Add a comment

Title Welcome

Comment

Attach a file
fE" None

Uploag

Add Cancel

(" Parcourir... )

. Type the subject and the content of your comment.
. Attach a file to your comment (this is optional).

5. Click on the Add button.

The comment is displayed in the Topic tab.

AW

® |f the topic is not moderated, the comment has the status "Published" and all the users with access rights to the

forum can read it.

Nuxeo features

My subscriptions

_J Welcome - by jdoe 19:34 ( Published )

Welcome on the Nuxeo features topic!

Add

Reply | De

® |f the topic is moderated, the comment has the status "Waiting for approval” and is not available in the topic. A
moderator is notified that you added a comment and he or she needs to approve it so that the comment becomes

available for all forum users.

_) Welcome - by jdoe 19:37 ( Waiting for approval )

Welcome on the Nuxeo features topic!

Add

Reply to a comment

You must have at least writing rights to reply to comments in a topic.

When a comment has been added, you can reply to it. The answer is inserted right after the comment it replies to.
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1. In the Topic tab, click on the Reply link displayed top right corner of the comment you want to reply to.
The reply form is displayed under the comment.

2. Fill'in the form.

3. Click on the Add button.
The reply is inserted after the comment it replies to.

q) Welcome - by jdoe 19:34 ( Published )

‘Welcome on the Nuxeo features topic!

Thanks! 1 already have some ideas of features (see attached file).

™ | NxFeaturesProposal.odt

Add

® |f the topic is not moderated, the reply has the status "Published" and all the users with access rights to the forum

can read it.

® |[f the topic is moderated, the reply has the status "Waiting for approval” and is not available in the topic. A
moderator is notified that you added a reply and he or she needs to approve it so that the reply is available for all

forum users.

i _) Re:Welcome - by jsmith 19:45 ( Published )
: If you are the moderator of the topic, your reply is automatically published.

Pictures

Pictures are usually created in a picture book, a folder adapted to pictures, that enables you to view your pictures in a slideshow, for instance.

they can be used in regular folders and in workspaces directly.
In Nuxeo DM, pictures (created in a picture book, in a workspace or in a folder) have some specific features available:

® rotation
® picture specific metadata extraction
¢ different size presentation

In this section, we will see how to:
® Manage picture books
® Create a picture book
® Edit a picture book
® View the content of a picture book
® Manage pictures

Manage picture books

Picture books are folders adapted to hold only pictures. As so, you have some specific parameters that you need to fill in when you create a

picture book.
A picture book can only hold pictures and other picture books.

Create a picture book

You need to have at least Write right to be able to create a picture book.
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1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

3. Fill in the document's creation form.
4. Click on the Create button.

: Available document types @ :
E Select the type of your new document in the list below. :
Document Collaborative Services
i Picture Folder Forum
i File . Blog site Email folder H
: 5 Note Workspace PictureBook :
| Ved . a L i
E % WebSite T E
i Iq i
: H

Picture book creation parameters

Field Description

Title Name of the picture book

Description What the picture book is about

Slideshow duration Time in seconds during which each picture of the pictures in the book

will be displayed during the slideshow

Views Different views and formats available for the pictures available in the
picture book.
Default views available are:

® Thumbnail: view used for the default picture book content view,
® Medium: intermediate size picture,

® QOriginal: original size picture,

® OriginalJpeg: original size picture in .jpg format.

Edit a picture book

You need to have at least Write right to edit a picture book.
When you edit a picture book, you edit some of its properties: title, description and slideshow duration. You cannot edit the picture views available
in the picture book.

1. Click on the Edit tab of the picture book. i
2. Edit the edition form's fields.
3. Optionally type a comment to keep track of why you edited the picture book. :
4. Click on the Save button.

Modifications are saved and the fact that you edited the picture book is tracked in History tab. :

View the content of a picture book

Beside the Content tab that enable the same features as in a workspace or a folder (selection of documents), a picture book has a View tab
displays the book's content as thumbnails. It is the picture book's default tab. However, the regular Content tab used on all folderish content is
available on picture book as well, to make it easy to have a synthetic view of the pictures author, versions, ect.

In the View tab of the picture book, click once on a picture to select it (keep CTRL touch pressed if you want to select several pictures) and click
twice on it to consult it. Selected pictures are displayed on an orange background.
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Scotland =

m Slideshow Content Edit | Alerts History

New Import a file

Picture Book:

Paste Add to worklist Copy Delete

A Slideshow tab is also available on picture books, in which the pictures are displayed in a slideshow.

Manage pictures

Pictures can be created in picture book, in folders and in workspaces. You can add pictures using all document creation means:

® New button
® Import a file button
® Drag&Drop.

When pictures are created, the EXIF and IPTC metadata of the pictures are automatically extracted. You can consult them in the Picture
metadata tab. EEXIF and IPTC metadata are not editable.

DSCF2312 =
View Summary Picture Metadata Edit Publish Relations Alerts Comments History Preview
EXIF
Date 6/28/09
Width 2848
Height 2136
Orientation TOP_LEFT
Equipment FUJIFILM FinePix F11
FNumber 4.7
Exposure time 1/210
1SO 150-200
IPTC
Caption
Category

When they are created, pictures are displayed in the View tab, that enables some picture management specific actions. Should the picture be
wrongly oriented, you can rotate it using the right and left rotation buttons available on this tab. It is in this tab that you can see the different sizes
available for the picture (sizes available are defined for the whole picture book) and download it in the format you need. Default size is medium
size.
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DSCF2312 =

m Summary Picture Metadata Edit Publish Relations Alerts Comments History Preview

Rotate Left Rotate Right Download

@ Medium O original () Thumbnail ) Originallpeg

Whatever the folder they have been created in, their behaviour and the actions available are the same: you will be able to preview and annotate th
em, link them to other documents, tag them, publish them and subscribe to email alerts. Note that workflow is not available on pictures.

Websites and blogs

Websites and Blogs are collaborative documents that are web publishing oriented. As so, they have a second interface that makes it easy to
display the documents of a workspace to the public. These specific presentations are built using Nuxeo WebEngine.

Websites and blogs have in common some specific behaviours, like the fact that they have some specific access rights and that comments can be
moderated.

NUXeOo Ballet Fan

Open Source ECM

Welcome on my blog, where | will post reports on all the ballets | see. Contextual links
I am a big fan of the Paris Opera Ballet, which is the company | see most often.
@ Paris Opera website

Last Blog Posts @ New York City Ballet
website
Wednesday 29 September 2010 Jjdoe

@ San Fransisco Ballet

Roland Petit evening at the Paris Opera website

Report on the show of sept. 28
Create entry

Here are my impressions on last night show at the Garnier Opera, dedicated to the choreographer Roland Petit.

Roland Petit (born in 1924) is a French choreographer who trained at the Paris Opera Ballet school and created many creative Blog Archive
ballets. He is the son of Rose Repetto, the founder of the the world-known ballet shoe company.
The evening was composed of 3 short pieces by Roland Petit: = 2010(1)
* Le Rendez-Vous September(1)
e Le Loup July(2)

e Le Jeune Homme et la Mort

June(6)
Blogs
Along with websites, Nuxeo DM includes blogs. Like websites, blogs are documents that make it easy to display your comments and documents,

in reverse-chronological order. And like websites, they are available via a webengine interface, that takes into account all the characteristics of a
blog.
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NUXeOo Ballet Fan

Open Source ECM

Welcome on my blog, where | will post reports on all the ballets | see. Contextual links
I am a big fan of the Paris Opera Ballet, which is the company | see most often.

@ Paris Opera website
Last Blog Posts @ New York City Ballet
website
Wednesday 29 September 2010 jdoe

; ; ; € San Fransisco Ballet
Roland Petit evening at the Paris Opera website
Report on the show of sept. 28
Create entry

Here are my impressions on last night show at the Garnier Opera, dedicated to the choreographer Roland Petit.
Roland Petit {(born in 1924) is a French choreographer who trained at the Paris Opera Ballet school and created many creative

Blog Archive
ballets. He is the son of Rose Repetto, the founder of the the world-known ballet shoe company.
The evening was composed of 3 short pieces by Roland Petit: = 2010(1)
* Le Rendez-Vous September(1)
e Le Loup July(2)
e Le Jeune Homme et la Mort June(6)

Blogs are accessible by a URL formed like http://server:8080/nuxeo/site/blogs/blog-name. A shortcut is also available from the top right corner of
the blog's "Summary" tab in Nuxeo DM interface (blog back-office).

Ballet fan =

Edit Preview Alerts History

New Import a file

=] Title # Modified Author Version State
a Q_) New York City Ballet website 9/29/10 411 PM John Doe Project
O Q Paris Opera website . 9/29/10 410 PM John Doe Project
o = Roland Petit evening at the Paris Opera 9/29/10 4:07 PM John Doe Project

In this section, we will see how to:
® Create a blog
® Add content to your blog
® Add a blog post
® Add a contextual link

Create a blog

Blogs can be created in workspaces only. You just need to have "Write" right to be able to create a new blog.

1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

3. Fillin the document's creation form.
4. Click on the Create button.

i Available document types @ i
E Select the type of your new document in the list below. :
Document Collaborative Services
- Picture Folder Forum
File ™ Blog Site Email folder
P Note . Workspace m PictureBook
[, Website .
i I i

Blog parameters
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Field Description

Blog name Type the name of your blog. This name will
be displayed on top of all blog's pages.

Baseline Type a brief description or catchphrase for
your blog. This baseline will be displayed on
all pages below the blog's name.

Email Type the webmaster's email address. This
address will be used for the contact link.

Logo Default logo is Nuxeo's. You can upload the
logo of your choice to replace Nuxeo's logo
with one adapted to your blog's subject.

Welcome text Type a text that will be displayed on the
home page of your blog.

Welcome Animation/Image You can add a swf animation or a picture on
your blog's home page.

Captcha Check the box your you want users to type
letters or digits from a distorted image
displayed on forms, to secure content
creation on your blog.

Moderation Type Select if comments posted on your blog
should be should be approved to become
visible by users (beforehand moderation) or if
they are published immediately (afterwards
moderation).

Add content to your blog

In a blog, you can create blog posts and contextual links.

Add a blog post

Blog posts are all created at the root of the blog. They are then automatically sorted by creation date in the left menu of the blog.

You need "Write" permission to be able to create blog posts. You can create them from the blog's back-office (DM's interface) or from the blog's
interface.

: 1. From the blog's homepage, click on the button Create entry. :
: 2. Fillin the creation form: :
® Title: type the name of your post. :
® Description: type a text describing what the post is about.
i ® Content: type the content of your post in the editor. :
3. Click on the button Save
: The post is immediately created and displayed. It is also displayed in the last blog posts. :

Add a contextual link

Contextual links are links displayed on the blog's home page.
They can be added from the blog's back-office only.

1. On the Content tab of the blog from the back-office interface, click on the New button.
2. On the modal window displayed, click on Contextual link.
3. Fillin the creation form:
® Title: type the text on which the user will click to open the link.
® Description: type an optional text describing why you add this link. The description is displayed on the blog's
interface.
® Link: type the URL of the link.
4. Click on the button Create.
The link is created and its Summary tab is displayed.
In the blog's interface, the link is displayed in the right column.
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Websites

Websites are documents is which you can publish webpages and contextual links. To make it even easier to display your documents, they have a
specific presentation, rendered using Nuxeo WebEngine.

Nuxeo Products

Presents All Products Of Nuxeo

Menu Welcome on my website presenting all Nuxeo products. & Add tags
Nuxeo Products

Nuxeo DM Create page

Nuxeo DAM

Nuxeo CMF

i Contact the author
Nuxeo Studio Contained pages
Contact

Nuxeoa DM
Nuxeo DAM RSS Feeds
Nuxeo CMF |:‘ Pages

Nuxeo Studio
[2] Comments

Last published pages
Nuxeo Studic
September | agministrator | 0 comments

The creation of a website takes place in workspaces, in the regular Nuxeo DM interface. Content creation, edition and commenting will preferably
take place in Nuxeo WebEngine interface. Website management will however take place in Nuxeo DM's interface, which is considered as the
website's back-office.

Websites are accessible by a URL formed like http://server:8080/nuxeo/site/sites/site-name. A shortcut is also available from the top right corner
of the website's "Summary" tab in Nuxeo DM interface (website back-office).

Nuxeo Products =

("1l | Edit || Preview | Alerts | History || Manage

New Import a file

=] Title & Modified Author Version State
O = Muxeo CMF 9/29/10 11:53 AM Administrator Project
a L Nuxeo DAM " 942910 11:53 AM Administrator Project
O = Muxeo DM 9/29/10 11:52 AM Administrator Project
B L Nuxeo Studio " 9/29/10 11:53 AM Administrator Project
Paste Add to worklist Copy Delete

In this section, we will see how to:
® Create a website
® Add content to a website
® Add a webpage
® Add a contextual link
® Manage the access to the website

Create a website

Websites can be created in workspaces only. You just need to have "Write" right to be able to create a new website.
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1. In the Content tab of the workspace, click on the New Document button.
2. On the window Available document types, click on the desired document.

Nuxeo Document Management 5.3 Documentation Center

Available document types

Document

- Picture

File

5 Note
Vedl

Select the type of your new document in the list below.

Collaborative Services

Folder Forum
. Blog site Email folder
- Workspace m PictureBook
WebSite 1

e

3. Fill in the document's creation form.
4. Click on the Create button.

e

Website parameters

Field

Site name

Baseline

Email

Logo

Welcome Text

Welcome Animation/Image

Captcha

Moderation Type

Add content to a website

In a website, you can create pages and contextual links.

Add a webpage

Description

Type the name of your website. This name will be displayed on top of
all website's pages.

Type a brief description or catchphrase for your website. This
baseline will be displayed on all webpages below the site's name.

Type the webmaster's email address. This address will be used for
the contact link.

Default logo is Nuxeo's. You can upload the logo of your choice to
replace Nuxeo's logo with one adapted to your website's subject.

Type a text that will be displayed on the home page of your website.

You can add a swf animation or a picture on your website's home
page.

Check the box your you want users to type letters or digits from a
distorted image displayed on forms, to secure content creation on
your website.

Select if comments posted on your website should be should be
approved to be visible by user (beforhand moderation) or if they are
published immediately (afterwards moderation).

Webpages can be created at the root of a website or in another page. You can create pages from Nuxeo DM's interface (which would be
considered as the back-office of the website) or from the website interface.
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1. In the website interface, click on the button Create page located in the right column. '
2. Fillin the creation form: !
® Title: give your page a title :
® Description: type an optional text describing what the page is about.
® Select the format used to present the content of the page and type the text in the editor displayed below. :
® Display this page in the webview menu: Select if you want the page to be displayed in the website menu.
3. Click on the button Save. i
The page is created and displayed. :

Add a contextual link

Contextual links are links that are displayed from a webpage, in the right column of the website. Contextual links can only be created from the
website's back-office, at the root of the application.

1. On the Content tab of the website from the back-office interface, click on the New button. '
2. On the modal window displayed, click on Contextual link. :
3. Fillin the creation form: :
® Title: type the text on which the user will click to open the link. !

® Description: type an optional text describing why you add this link. The description is displayed on the website's :
interface.

® Link: type the URL of the link. 1

4. Click on the button Create.
The link is created and its Summary tab is displayed. !

In the website interface, the link is displayed in the right column. 5

Manage the access to the website

In a website, access rights can be managed on the website itself and on the webpages. The steps to grant or refuse access rights are the same
as on a workspace or a folder (see Manage access rights).

However, websites have specific access rights:

® Comment
®* Moderate

In a website, users with "Read" write cannot comment on pages unless they are explicitely give the right to comment.
If beforehand moderation is applied to the website, then users with "moderate” rights will have to approve comments so that they can be viewed
by other users.

Users with "Write" permission can comment on pages. Comments are still submitted to moderation.
Users with "Manage everything" permission are automatically moderators.

Email folders

Email folders are folders in which you can fetch emails to store and share them in your Nuxeo DM application.

The email folder is not intented to be a webmail. It will fetch the unread emails on your email server when you manually trigger the fetch from
Nuxeo DM interface.

When emails are imported in Nuxeo DM, some metadata are automatically extracted from the email:

Subject

Sender

Sending date

Recipients

CC Recipients

Text: content of the email
Attachments

1 The emails imported in the email folder cannot be modified in Nuxeo DM.

Create an email folder
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: 1. In aworkspace, click on the New button.

; 2. In the modal window displayed, click on Email folder

! The email folder creation form is displayed.

; 3. Fillin the creation form (see parameters below) and click on the OK button.
The Content tab of the email folder is displayed.

Praject & ofMcal emalls

=1

i e

You can now fetch emails.

Email folder parameters

Field Description

Title Name of your email folder

Email Email address of the account from which the emails will be fetched.

Password Password of the email account from which the emails will be fetched.

Protocol Select the receive protocol used for the email account.

Host Type the name of the host of the email account.

Port Type the port number.\ Default value is 993, which should be ok in
most cases. Check with your administrator if this value should be
changed.

Socket factory fallback Default value is set to "Yes". This parameter sets the behaviour in

case the socket used to connect Nuxeo DM server to the email server
fails to be created using the implemented socket factory.

Socket factory port Port used to connect Nuxeo DM server to the email server. Default
value is set to 993.

Start TLS (IMAP) Default value is set to "Yes" to secure exchanges with the email
server.

SSL protocols (IMAP) Default value is "SSL". You can add other protocols, separated by
whitespace.

Limit of new fetched emails Indicate the maximum number of emails to be fetched at the same
time.

The actions available on an email folder are:

Edit the folder (see parameters above),
Subscribe to alerts,

Manage the access to the folder,
Manage the trash of the folder.

Fetch emails
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1. In your email client, mark the emails you want to fetch as unread.
2. In Nuxeo DM, open the email folder.

The Content tab is displayed.
3. Click on the Check email button.

The unread emails are imported in the email folders.

Froject & offichal emalls

4. To open a mail, click on its subject.
M= G live planning

=n

Emails cannot be edited, but you can comment and annotate them, link them to other documents and subscribe to alerts.

Managing Nuxeo DM

Administrators can configure some elements directly from Nuxeo DM's user interface.

As an administrator, you are in charge of managing users in groups. You can create news users and groups, edit their properties, or even delete
users or groups.
You can can also manage vocabularies, i.e. the labels displayed in drop down lists.

At a space level, space managers are in charge of managing access rights.

Manage access rights

Only users with management rights can manage the access rights of a space.

Managing access rights means granting or denying access rights in a space. The access rights management screen is available as a sub-tab in
the Manage tab of the space.

The access rights management sub-tab is accessible composed of three parts:
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Content  Edit | My subscriptions | History m

Access rights  Theme Subscriptions Publication targets Trash

/I_rlherited rights _\
Type Username Granted permissions Denied permissions
& Administrator Manage everything
3 members Read Version
\Dh(k permissions inheritance j
/" Local rights ™
=] Type Username Granted permissions Denled permissions
a & John Doe Write
Remove permissians) _/
ﬂdd a new security rule: \

Search for users oF groups Action

To start the search, please type at least 3 character{s) e

Write

Add permission

El

&

1. the Inherited rights part displays rights that were granted or denied in a parent space;
2. the Local rights part displays the rights that were granted or denied in the current space;
3. the form to grant or deny access rights in the current space.

Grant access rights
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1. Click on the Manage tab of the space.
The Access Rights sub-tab is displayed.
2. In the form, type the username of the user you want to grant rights to.
To give access rights to a group, type the group's name.
The names of the users or groups corresponding to the typed characters are automatically displayed as you type.

Search for users or groups

ala

- st 3 character(s
ZrMlan Smith (s)

s
iZ»Alan Turing

3. Click on the user you want to give access rights to.
4. Select the right to grant in the Permission drop down list.

Action Crant | l

Permission Write -

Add permission

5. Click on the Add permission button.
The user and its rights are displayed in the Local Rights part of the screen.

Local rights =

O Type Username Granted permissions Denied permissions
=] £ Alan Smith Write

(=] £, John Doe Write

0 »3\ Alan Turing Manage everything

Save local rights

6. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Deny access rights

If a user has inherited rights that you don't want him to have in the current space, you can deny him these rights. If you want to deny access rights
to a large number of users, block rights inheritance and give access rights only to the users you want to be able to access the workspace or
section.
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1. Click on the Manage tab of the space.
The Access Rights sub-tab is displayed.
2. In the form, type the username of the user you want to grant rights to.
To deny access rights to a group, type the group's name.
The usernames corresponding to the typed characters are automatically displayed.

Search for users or groups

ala

- st 3 character(s
ZrMlan Smith (s)

s
iZ»Alan Turing

Click on the user you want to deny rights to.

Select the right to deny in the Permission drop down list.

Click on the Add permission button.

The user is in the Local rights form. The denied rights is displayed in the Denied permissions column.

aprw

Local rights =

=] Type Username Granted permissions Denied permissions
O »3 Alan Smith Write Remove

o & John Doe Write

O 8 Alan Turing Manage everything

Save local rights

6. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Remove a user from local rights

If you want to refuse rights to a user, and that these rights have been granted in the current space, you can remove the user from the local rights.

1. Click on the Manage tab of the space.

The Access Rights sub-tab is displayed.
2. Inthe Local Rights part of the screen, check the box corresponding to the user you want to remove.
3. Click on the Remove permission(s) button.

The user is removed from the Local Rights table.

Local rights
Wo local right is defined on the current document

Save local rights

4. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Block rights inheritance

The rights that are granted or denied in a space are applied to the space's content, including its sub-spaces. You thus have the same rights in the
sub-spaces as in the parent space. That is called rights inheritance.

You can block this inheritance. It enables you to block the access of a sub-workspace to the workspace's users, for instance, or to deeply modify
the access rights in the sub-workspace.
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1. Click on the Manage tab of the space of which you want to the access rights.
The Access Rights sub-tab is displayed.

2. Check the box Block permissions inheritance located under the Inherited Rights table.
The inherited rights table is not displayed anymore.

Inherited rights

ﬁ_ﬂﬁluck permissions inheritance

You are added in the list of the local rights, like the administrators group.

Local rights

O Type Username Granted permissions Denied permissions
0 &> administrators Manage everything

O E\ Alan Turing Manage everything

In the Access Rights tab of the possible sub-workspaces of the workspace whose rights are blocked, a group Everyone is
denied all rights.

Inherited rights

Type Username Granted permissions Denied permissions
2 administrators Manage everything

5 Alan Turing Manage everything

2 Everyone Manage everything

0

Block permissions inheritance

You can now grant access rights to users.

gt ooy~ Aot H

Manage groups

Groups of users can be created and their properties modified directly in Nuxeo DM. Groups of users are used to manage access rights more
easily.

There are two default groups in Nuxeo DM:

® administrators: the members of this group are administrators of the application. They can manage users, vocabularies and documents.
®* members: the members of this group by default have reading rights on all the content of the application.

Groups can be composed of users and of sub-groups. Sub-group's members automatically become members of the parent group. Thus, they are
granted all the access rights you give to the group.

Users and groups directories are available using the Users & groups link in the page header.

You are logged as Administrator | Dashboard | Personal Workspace | Users & groups | Vocabularies | Themes | Log out

Groups parameters

Field Description

Group name The name of the group is its ID.
Group's members Users that belong to the group.
Sub-groups Groups that belong to the group.

Create a group

Only administrators can create groups of users.
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1. Click on the Users & groups link in the page header. :
The directory opens on the Users tab. :
. Click on the Groups tab. :
A search form and the list of the existing groups is displayed.
3. Click on the Create a new Group button. i
4. Fill in the creation form.
5. Click on the Save button. !
The View tab of the group's card is displayed. ’

N

Edit a group
Only administrators can modify groups.

Modifying groups consists in adding or removing members of the group. The name of the group cannot be changed.

members
Delete
View  Edit
Group's members Search for users
@ £ John Doe
@ £ Marge White
To start the search, please type at least 3 character(s)
@ A& Clark Parker
Sub-groups Search for groups
@ g project-managers
To start the search, please type at least 3 character(s) @ & redactors
Save
i i i B E LR L EL DL "

1. Click on the Users & groups link in the page header.
The directory opens on the Users tab.
2. Click on the Groups tab.
A search form is displayed.
3. Search a group and click on its name to open its card.
The card displays the members and sub-groups of the group in the View tab.
4. Click on the Edit tab.
The modification form is displayed.
5. Modify the group's members and click on the Save button.
The View tab of the group is displayed with the modifications you just made.
The new group members are immediately granted the group's access rights. The users who are no longer members of the
group are denied group's access rights. However they still have their individual access rights.

Delete a group

Only administrators can delete groups.

1. Click on the Users & groups link in the page header. :
The directory opens on the Users tab. :
2. Click on the Groups tab. :
A search form is displayed. !
3. Search the group to delete and click on its name to open its card. :
The card displays the members and sub-groups of the group in the View tab.
4. Click on the Delete button. :
A window pops up.
5. Click on the OK button.
The group search form is displayed. The group is displayed and its members lose the group's access rights. :

Manage users
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Only administrators can manage users and groups. They can create new users and groups, modify their properties or delete them. It is also
possible to connect Nuxeo DM to an external directory (LDAP directory for instance). This procedure is explained in the Nuxeo EP Reference
Guide.

Users can only consult users and groups directories. Administrators can create, edit and delete users and groups.

(D When you use an external directory for users and groups, the actions available on users and groups are limited, even to administrators.

Users and groups directories are available using the Users & groups link in the page header.

You are logged as Administrator | Dashboard | Personal Workspace | Users & groups | Vocabularies | Themes | Log out

User's parameters

Field Description

Username Name the user will use to log in.
First Name First name of the user

Last Name Last name of the user

Company Company or organization of the user
Email email of the user.

This address is used for alerts.

Password User's password
Password (Verify) User's password
Groups for this user Groups of which the user is a member.

User must be at least in ‘administrators' or ‘members' group, or one of
their sub-groups.

Virtual groups for this user

Create a user

Only administrators can create new users.

By default, Nuxeo DM has one user, called Administrator. This user is the administrator. You must use this user to create new users and delegate
them access right.

@ User must be at least in ‘administrators' or ‘members' group, or one of their sub-groups to be able to access the application's content.

1. Click on the Users & groups link in the page header. ;
The members management interface opens on the user directory search form. i

. Click on the Create a new user button. :
3. Fillin the user creation form.
Mandatory fields are indicated by a red asterisk. :
4. Click on the Save button.
The card of the new user is displayed. You can modify its properties and its password. 1
The user can immediately connect to the Nuxeo DM application using his or her username and password. :

N
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jdoe
Delete

View Edit Change password

Username Jjdoe

First name John

Last name Doe

Company Muxeo

Email Jjdoe@nuxeo.com

Groups for this user
= members

Virtual groups for
this user

Edit a user's properties

Only administrators can modify other users' properties. But every user can modify his or her own properties.

You cannot edit the username, as it is the ID of the user on the application.

jdoe
Delete

View Edit Change password

Username jdoe

First name ‘John |
Last name ‘ Doe |
Company ‘ Muxeo |
Email *

‘ jdoe@nuxec.com |

Groups for this user Search for groups

@ g members

To start the search, please type at least 3 character(s)

Virtual groups for
this user

Sawve

When you are using an external directory for users management, the Edit tab is not displayed as you cannot edit the users' properties (managed
directly from the directory).
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The members management interface opens on the user directory search form.

. Search a user and click on the user's name to open his or her card.

The user's card is displayed.

. Click on the Edit tab.
. Modify the fields in the modification form.
. Click on the Save button.

The View tab is displayed with your modifications.

Change a user's password

Only administrators can modify other users' password. However every user can modify his or her own password.

When you use an external directory for users management, the Change password tab is not displayed as you cannot edit your password.

jdoe
Delete

WView

Edit Change password
Passwaord

Password (Verify) | ‘

Virtual groups for

. Click on the Users & groups link in the page header.

this user
Save
To modify a user's password:
"""""" 1. Click on the Users & groups link in the page header.

The members management interface opens on the user directory search form.

. Search a user and click on the user's name to open his or her card.

The user's card is displayed.

. Click on the Change password tab.
. Type the new password and confirm it.
. Click on the Save button.

The View tab is displayed. The user must use his or her new password the next time he or she logs in.

Delete a user

Only administrators can delete users.

(D Deleting a user is a permanent action.

The members management interface opens on the user directory search form.

. Search a user and click on the user's name to open his or her card.

The user's card is displayed.

. Click on the Delete button.

A window pops up.

. Click on the OK button.

The user is deleted. He or she cannot log in to the Nuxeo DM application.

Manage vocabularies

This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page.

Copyright © 2010-2016 Nuxeo.

75

. Click on the Users & groups link in the page header.



http://doc.nuxeo.com/x/GATF

NU32Ze O Nuxeo Document Management 5.3 Documentation Center

Only administrators can consult and manage vocabularies.

Vocabularies are the lists of labels used in the application, for instance in drop down lists. A vocabulary is composed of several entries, that are
the options in the drop down lists. Some vocabularies are hierarchical, i.e. they have several levels. For instance, the Subjects metadata uses a
two level vocabulary. First level is Topic. Second level is Subtopic and each entry is linked to a Topic entry.

5uh_]gc15@ Daily lite & (| Select a value =) Add
Hurman science Astronautic
Society m Electronic
CEITTTI ¥ || Eneray :

Functional administrators can only modify or delete vocabularies. They cannot create a new vocabulary from the user interface.

Consult vocabularies

You can consult the vocabularies from any page of the application by clicking on the Vocabularies link in the page header.

You are logged as Administrator | Dashboard | Personal Workspace | Users & groups | Vocabularies | Themes | Log out

All vocabularies editable from user interface are listed in the vocabularies management interface.

1. Click on the Vocabularies link, located at the top of the page.
The list of the application vocabularies is displayed.

Vocabularies

external gadget list
continent
country :
topic i
subtopic i
subject 5
sort_order i
search_operators :
predicates :
inverse_predicates i
language

2. Click on the name of the vocabulary you want to consult.
The vocabulary entries are displayed.

subtopic

LAdd a new vocabulary entry
Parent 1] Label Obsolete Order
Art art history label.directories.subtopic.arthistory No 10,000,000 Modify Delete
Art literature label.directories.subtopic.literature No 10,000,000 Modify Delete
Art cinema label.directories.subtopic.cinema No 10,000,000 Modify Delete
Art comics label.directories.subtopic.comics No 10,000,000 Modify Delete
Art show label.directories.subtopic.show No 10,000,000 Modify Delete
Art danse label.directories.subtopic.danse No 10,000,000 Modify Delete

(D By default, the labels of default vocabularies entries are the IDs of labels in properties files of source code.

Vocabulary entries parameters

Field Description
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ID Unique identifier for the vocabulary entry. The ID is not displayed to
users.

Parent This field is only displayed on hierarchical vocabularies second level.
It indicates to which 1st level entry the current value is linked.

Label Value of the entry that will be displayed to users on the application.

Obsolescence Indicates if the entry should be displayed in the available values on
edition.

Order Indicates the rank of the entry in the vocabulary.

Order is set at "10,000,000" by default.

Edit vocabularies

When you modify a vocabulary, you can add new entries, edit or delete them.

Add a new vocabulary entry

.....................................................................................................................................................................................

1. Consult the vocabulary to add an entry to.

2. Click on the Add a new vocabulary entry link.
The entry creation form is displayed under the link.

3. Fillin the entry creation form.

topic

= Add a new vocabulary entry

Entry details

ID*

Label

Obsolete @ No O Yes
Order 10,000,000
Create Cancel

4. Click on the Add button.

.....................................................................................................................................................................................

Edit a vocabulary entry

Editing a vocabulary entry can be:

® change its label,
®* make it obsolete,
® change its order.

When you make an entry obsolete, it means that it will not be displayed in the available choices when you edit a document. But the value is still
displayed on Summary tab of documents.
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1. Consult the vocabulary in which you want to edit the entry.
Click on the Modify button corresponding to the entry you want to modify.
The entry modification form is displayed.

2. Edit the entries properties.

3. Click on the Save button.
The list of the vocabulary entries is displayed.

topic
[ art
Label label.directories.topic.art
Obsolete @ Mo G‘r’es
Order 10,000,000
S5ave Cancel

Delete a vocabulary entry

(D Deleting a vocabulary entry is a permanent action.

1. Consult the vocabulary to delete an entry from.
2. Click on the Delete button of the entry to erase.
3. On the window that pops up, click on the OK button. H

Working in sections

When a document is finished and ready for distribution, you must publish it in a section. Sections are spaces dedicated to the distribution of
documents to a wider audience.

Sections are spaces that are managed like workspaces. Like for workspaces, there is no section that is automatically created by default, except
for the sections root. You are free to organize your section the way it fits your needs or your project the best. The section tree is completely
independent from workspaces. Their structure is not linked. Still, you can guide users as to where they should publish documents from a specific
workspace using the publication targets.

As in workspaces, the access to sections is determined by access rights.

The main difference with workspaces is the fact that documents can't be edited in sections. The only actions available on published documents
are:

® relations actions,
® annotation actions,
® alerts.

Publishing a document means publishing the version of the document as it is at the time of publication. If you modify the document in the
workspace once published, it is not modified in the section. Published documents are for consultation only and cannot be modified. If you want to
modify a published document, you must modify it in the workspace and then publish the modified version of the document.

When you want to publish a document, you need to submit it to publishing. When the document is submitted to publication, the section's
managers can approve the publication submission, that is to say publish the document, or reject it. In that last case, the document is not available
in the section. However, it is still available in the workspace. You can modify it and submit it again.

Publishing documents

Publishing a document means publishing the version of the document as it is at the time of publication. If you modify the document in the
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workspace once published, it is not modified in the section. Published documents are for consultation only and cannot be modified. If you want to
modify a published document, you must modify it in the workspace and then publish the modified version of the document.

When you want to publish a document, you need to submit it to publishing. When the document is submitted to publication, the section's
managers can approve the publication submission, that is to say publish the document, or reject it. In that last case, the document is not available
in the section. However, it is still available in the workspace. You can modify it and submit it again.

In this section, we will see:
® Submit a document to publishing
® Approve document publishing
® Reject document publishing
® Unpublish documents

Submit a document to publishing

Only users with writing or management rights in the workspace can submit a document to publication.

You can submit a document in several sections. The publishing workflows in the different sections are independent. The document can be
published in a section and rejected in another one. The list of the sections in which you can publish a document is defined by your access rights.
You can submit a document in sections in which you have at least reading rights.

1. In the workspace, open the document to publish.
2. Click on the Publish tab.
3. Use the drop down list to select the domain you want to publish the document in.

@ If you use only the default domain, the domain is selected by default.

4. Unfold the sections tree and click on the Publish here link corresponding to the section you want to publish the document
in.

Nuxeo DM Install Guide =

Summary Edit Files W Relations Workflow || Alerts Comments History Preview

Sections | Local Sections {Default Domain) j ‘

= == Sections
o 2 IT publishing sections ® publish here
= =2 Quality / Procedure sections @ Publish here
| Product procedures @ publish here

—| Quality guidelines 4 pyblish here

The version number of the submitted document is indicated in the publication form.
Nuxeo DM Install Guide =

Summary Edit Files W Relations Workflow Alerts Comments History Preview

Sections | Local Sections (Default Domain) j‘

&[5 Sections
& = IT publishing sections ¥ Publish here
= =2 Quality / Procedure sections ¥ Publish here
| Product procedures @ Publish here
— Quality guidelines @ publish here
Title Current version Action

Default Domain>Sections>Quality / Procedure sections>Product procedures 1.0

The document is available in the section for users with management rights only. It is also displayed in their dashboard as a
pending document. The document must be approved to be available to all section readers.

@ If you have management rights in the selected section, the document is automatically published. It doesn't need
to be approved.

In the workspace, the document's minor version is automatically incremented.

Approve document publishing
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Users with write and management rights in the section can approve the publishing of a document.

When a document is submitted to publication in a section in which you have management rights, it is displayed in your dashboard. You must then
approve or reject the document.

1. Click on the Dashboard link in the top right corner of the window, to open your dashboard.
The pending documents are displayed in your tasks.
nuxeo - DM | Dashboard | Personal Workspas | Users & groups | Log out v

[ Default Domain ‘:} Change  Back to document base

Change Layout

Add A Widpet
=)= @]
Nom de la tache Titre Directive Commentaire Echéance Création
(=) 5] )
Document i publier Nuxeo DM Install Guide 10/18/2010 11:25 " -
w DR
Titre Derniére modification Auteur
[8  Cross-functional Projects 10/01/2010 11:14 Administrator
[)(G][%] [E@ Functional documentation 10/01/2010 11:12 Administrator
Nom de la tiche Titre Création [ Technical documentation 10/01/2010 11:14 Administrator
[ smith 10/18/2010 11:15 system

2. Click on the pending document.
The document opens in the section on its Summary tab. It has a Publishing part that has a Reject and a Publish buttons.
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Unpublish documents
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access to the document.
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